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Welcome to the Network Performance Server

The Network Performance Server (NPS) enhances NNMi's network management capabilities by

introducing a foundation for network performance management.

With the infrastructure provided by the NPS, you can use add-in products like the HP NNM iSPI Per-

formance for Metrics (iSPI Performance for Metrics) to view context-specific reports that help you

understand performance bottlenecks in the network.

At the core of the foundation provided by the NPS is the column-based database management sys-

tem (DBMS), which enables you to effectively store, access, and track the network performance

data.

Different extension packs introduced by iSPI Performance products add rules and definitions to

the NPS deployment to generate reports. These rules and definitions, enable the business intel-

ligence component—the BI Server—to generate rich and elaborate reports.

Documentation Conventions

The iSPI Performance documentation uses the following conventions:

Symbol Meaning

%nnminstalldir% Windows only. The environment variable for the NNMi application directory. This var-
iable is automatically created by the NNMi installer. If you install the iSPI Per-
formance on an NNMi (Windows) management server, all application files of the
iSPI are placed here.

%nnmdatadir% Windows only. The environment variable for the NNMi data directory. This variable
is automatically created by the NNMi installer. If you install the iSPI Performance on
an NNMi (Windows) management server, all the data and configuration files of the
iSPI are placed here.

<Install_Dir> Windows only. The iSPI Performance application directory. When you install the iSPI
on the NNMi management server, the iSPI installer uses %nnminstalldir% as the
application directory for the iSPI.

<Data_Dir> Windows only. The iSPI Performance data directory. This directory contains all the
configuration and data files used by the iSPI Performance. When you install the iSPI
on the NNMi management server, the iSPI installer uses %nnmdatadir% as the data
directory for the iSPI.

On Linux, the iSPI Performance installer directly installs the necessary files into the following directories:

l Application files: /opt/OV

l Data and configuration files: /var/opt/OV

Page 8 of 97



iSPI Performance for Metrics Online Help
Administration Overview

Administration Overview

The NNMi administrator is also an administrator for the iSPI Performance. The iSPI Performance accom-
modates one administrator at a time. This restriction avoids conflicts and satisfies OEM licensing require-
ments. Since administrator permissions are broad, and potentially hazardous in the wrong hands,
anyone with administrator access to the BI Server Portal must be familiar with BI Server tutorials and BI
Server documentation.

To run a report, or to access the ad hoc query features available from the BI Server Portal, you must be
logged on to NNMi. When you launch NNMi, use the Fully-Qualified Domain Name (FQDN). This way of
launching NNMi enables a security function known as Single Sign-On (SSO). When SSO is enabled, you
need not log on a second time when you move from NNMi to a report.

Overview of NPS Operations

The following topics contain background information, procedures for maintaining the NPS, and infor-
mation about tasks that may be necessary from time to time:

l "Location of Program and Runtime Files"

l "Tables and Data Dimensions "

l "Data Retention Defaults"

l "Single Sign-On Security(SSO)"

l "Monitoring the NPS Processes"

l "Time Changes and Time Zones"

l "Scheduling Reports"

l "Setting Thresholds for Metrics"

l "Support for Application Failover"

l "BI Server Portal"

l "Troubleshooting Tips"

BI Server Documentation

The following BI Server documents are copied to your system when you install the iSPI: 

BI Server Administration and Security Guide

BI Server Getting Started

BI Server Go! Office User Guide

BI Server Performance Tuning: Cheat Sheet

BI Server Performance Tuning: Settings

BI Server Troubleshooting Guide

BI Server Configuration User Guide

BI Server Connection Quick Tour

Query Studio Quick Tour

Query Studio User Guide

To access these documents, click Help from the BI Server portal.
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Information about Commands

Click here to open a list of command links. On Windows, many of the commands listed on this page are
Start menu options. Click the link to open a reference page. The reference page provides the following
information about each command:

l Name

l Synopsis

l Description

l Author

Location of Program and Runtime Files

The NPS consists of static application software files and dynamic runtime files. The default path for static
application software is:

Windows: C:\program files(x86)\HP\HP BTO Software 

UNIX/Linux: /opt/OV 

The NNMPerformanceSPI directory contains the following folders:

l bin

l config

l Docs

l Installation

l extensionpacks

l java

l lib

The default path for the dynamic runtime files is:

Windows: C:\Documents and Settings\All Users\Application Data\HP\HP BTO Software

UNIX/Linux:/var/opt/OV

The performance of the NPS depends on the I/O performance of the disk subsystem where this directory
resides. We strongly recommend that this data location is hosted on a high-performance file system,
such as a local multi-disk RAID0/5 array.

The NNMPerformanceSPI directory contains the following folders:

l contentstore

l database

l Component_Health

l Interface_ Health

l nnmappfailover

l logs

l PerfSPI_Diagnostics

l rconfig

The above folders are placed by the default NPS installation. Additional folders may be present if addi-
tional extensionPacks (for example, Metrics customPoll, or Traffic extensionPacks) are present.

Page 10 of 97

CommandRef/index.html


iSPI Performance for Metrics Online Help
Administration Overview

Tables and Data Dimensions

The NPS uses three kinds of data tables to store data:

l Aggregate

l Live

l Archive tables

The BI Server automatically picks the appropriate table based on the selected granularity of the data and
its time span.

l If you are looking for data with one hour grain and above it will pick the aggregate table

l If you are looking for data less than one hour grain and within last two days it will pick the live table

l If you are looking for data less than one hour grain and more than two days ago it will pick the
archive table

The retention period for data in the aggregate table and the live table is not configurable; the retention
period for archive data tables is configurable. The default retention period for archive data is 14 days. To
adjust the default, use the Configuration Utility.

Increasing the retention of detail data provides longer online access to the fine-grained data, which is
useful for forensic network analysis, but will require more disk space and require more computing
resource when querying.

Each table is partitioned, the individual pieces are stored in multiple files, and the file format is pro-
prietary. A measure, sometimes referred to as a fact, is a numeric value stored in a table. Every measure
is defined in terms of multiple dimensions. For example, bytesIn is a measure. Without context, for exam-
ple, without an interface and a time period, this measure has no meaning. Each table is defined by mul-
tiple dimensions.

Data Retention Defaults

Data retention varies from table to table. Retention per-table is as follows:

l The live table retains data for 1 day

l The aggregate table retains data for 70 days

l The detail archive table retains data for 14 days

If you want to modify the default detail archive retention, use the Configuration Utility.

Single Sign-On Security(SSO)

Installing the NPS enables a security function known as Single Sign-on (SSO). SSO allows the NPS to
recognize the same usernames and passwords that the NNMi Console recognizes. When SSO is ena-
bled, a user who is already logged in to NNMi can move from NNMi to a report without having to log in
again.

For SSO to operate, the following conditions must be met:

l The NNM system and the NPS system must be configured with fully qualified domain names.

l The user must use the fully-qualified domain (not "localhost" or the machine name minus the
domain) when launching the NNMi console.

 A fully-qualified domain name (FQDN) has this format:

http://<fully-qualified-hostname>/nnm
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If the user launches NNMi using an unqualified host name, the SSO servlet will open a login window and
force the user to log in again.

Note: If the address, or the domain, of the NNM management server or the NPS system changes after
you install the NPS, you should re-run the enablement script on NNMi. Rerunning the enablement script
will configure NNMi with updated location information.

Direct Access to the NPS

You can access the NPS directly, without going through NNMi, by pointing your browser at:

http://<fully-Qualified-serverName>:9300/PerfSpi/login

When the login window opens, enter the same username and password you use to launch NNMi. After
you are authenticated, the Report Menu opens.

Monitoring the NPS Processes

The NPS includes reports that monitor NPS processes. Click the Self Diagnostics tab on the Report
Menu to view the available report links to:

l Calendar

l Chart Detail

l Heat Chart

l Most Changed

l Top N

l Top 10 Task Duration

Click Self Diagnostics for more details

Scheduling Reports

Follow these steps to schedule a report:

1. Start the BI Server Portal (from the Start menu or from Report Links).

2. Click BI Server Connection. Open the report folder that contains the report you want to schedule.

3. Under the Actions column to the right, locate and click the schedule icon (calendar with clock). The
schedule form opens.

4. Select a frequency. Your options are:

a. By day

b. By week

c. By month

d. By year

5. Select a start date and time.

6. Select an end date and time.

7. Click OK.

Setting the Same Schedule for Multiple Reports

You can set the same schedule for multiple reports by creating a job. A job identifies a collection of
reports, report views, or queries that are scheduled together and share the same settings. To set the
same schedule for multiple reports:

1. Click the New Job button on the toolbar.
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2. Give the new job a name and specify a folder. The new job wizard opens.

3. Select steps. Click Set...

4. Select the format and language for the job; click OK.

5. Select references to individual reports; click Add.

6. Move reports from Available to Selected.

7. You can submit the steps in sequence or all at once. If you want to modify the sequence of steps, click
Modify the sequence... and then rearrange the sequence of steps.

8. Click Finish.

9. Select a frequency, indicate the start date, start time, stop date, and stop time.

10. Click OK.

Setting Thresholds for Metrics

"Setting Thresholds"

"Terminology"

Until thresholds for Interface Health metrics are set, Interface Health reports will not track exception
counts. Until thresholds for Component Health metrics are set, Component Health reports will not track
exception counts.

NNMi does not set thresholds for performance metrics for you, automatically. Setting thresholds is a man-
ual step. If you have the Interface Health and Component Health extension packs, you can set thresholds
for the following metrics:

1. Discard rate in

2. Discard rate out

3. Error rate in

4. Error rate out

5. Utilization in

6. Utilization out

7. CPU 5 second utilization

8. CPU 1 minute utilization

9. CPU 5 minute utilization

10. Memory utilization

11. Buffer utilization

12. Buffer miss rate

13. Buffer failure rate

Although you may want to see exception counts as soon as possible, setting thresholds right away may
not be feasible. This is because you probably won't be ready to set thresholds until you are better
acquainted with the way your network behaves. You need to know what is normal for your network, and if
you set thresholds prematurely, problems may arise. For example, if the thresholds are wrong, NNM may
detect too many exceptions, and if you configure NNM to generate incidents in response to threshold con-
ditions, NNM may generate too many incidents.
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Setting Thresholds

Follow these steps to set thresholds for a node group or an interface group. If you are setting thresholds
for multiple node groups, or multiple interface groups, you are not required to set the same thresholds
per group. 

1. Open the NNMi console.

2. Select Workspaces > Configuration > Monitoring Configuration.

3. Click the Node Settings tab, or the interface settings tab.

4. Select a row in the table (a node group, or an interface group) and click the Open icon. The def-
inition form opens.

5. Verify that Performance Monitoring is enabled for this node or interface group. Performance Mon-
itoring is a prerequisite for threshold monitoring and you will see this option off to the left side of the
window.

6. On the Threshold Settings tab, set threshold values for every attribute you want to monitor for thresh-
old conditions.

7. When you are done, click Save and Close to return to the Interface/Node Settings form.

8. Click Save and Close to return to the Monitoring Configuration form.

9. Click Save and Close.

Terminology

l High Value (HV): Any value above this value is in the high range; any value in the high range
triggers a High status.

l High Value Rearm (HVR): Any value below High Value; indicates that the High status has ended.

l High Trigger Count (HTC): The number of consecutive polls a high value must remain the same
before the status changes to High. A trigger count of 1 is usually appropriate.

l Low Value (LV): Any value below this value is in the low range; any value in the low range triggers a
Low status.

l Low Value Rearm (LVR): Any value above Low Value;indicates that the Low status has ended.

l Low Trigger Count (LTC): The number of consecutive polls a low value must remain the same
before the status changes to Low. A trigger count of 1 is usually appropriate.

Support for Application Failover

Application Failover for NNMi ensures redundancy. Failover allows a secondary NNMi server to take
over immediately following the failure of a primary NNMi server. Failover relies on jboss clustering tech-
nology, ongoing file system synchronization, and a Java keystore file that must be copied from NNM to
the NPS. Copying the keystore file is a manual step.

The NPS supports NNMi Application Failover. From the perspective of anyone using the NPS, Appli-
cation Failover is a transparent event, for users as well as for the administrator. Aside from a minor inter-
ruption in service lasting about 15 minutes while failover is in progress, users won't be aware that a
failover took place, and the administrator won't be required to perform any special tasks related to fail-
over.

The ability of the NPS to support application failover depends on files it retrieves from the primary server
in the cluster. The NPS retrieves these files during startup. As soon as the NPS has the files, it begins
monitoring the status of the primary server by checking for status changes every 5 minutes. If the NPS
detects a status change, the following events take place automatically:

l The NPS determines which server is the new primary server

l The NPS redirects data collection to a shared directory on the new primary server
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l The NPS begins collecting data (metrics and topology files) from the new primary server in the
cluster

Immediately after these events take place, NPS users will be able to link from the NPS to NNMi views on
the new primary server, just as they were able to do before failover.

Prerequisites for Successful Application Failover

Application Failover support will not succeed unless the following prerequisites are met:

1. Every installation of NNMi is set up and configured the same way.

2. You ran the NPS enablement script on every server in the cluster. 

3. You responded to enablement script prompts exactly the same way each time you ran the ena-
blement script.

4. On each server, you established the same path to the datafiles folder. 

5. You copied a certificate (a java keystore file) from NNM to the NPS.

Copying the Keystore File from NNMi to the NPS 

To copy the shared certificate file—cluster.keystore—from NNMi to the NPS, follow these steps:

1. Navigate to the cluster.keystore file on NNMi:

Windows
%NnmDataDir%\shared\nnm\conf\nnmcluster\cluster.keystore

UNIX
/var/opt/OV/shared/nnm/conf/nnmcluster/cluster.keystore

2. Copy cluster.keystore to the following directory:

Windows
%NnmDataDir%\NNMPerformanceSPI\nnmappfailover\keystore

UNIX
/var/opt/OV/NNMPerformanceSPI/nnmappfailover/keystore

The keystore is used to enable access to the NNMi cluster. We recommend using a secure copy mech-
anism, for example, SCP or USB key. 

Messages Related to Failover

The following table provides a list of INFO, WARN, and ERROR messages that pertain to Application Fail-
over.

Condition Message Comments

Failover not
enabled

DEBUG: NNM Appli-
cation Failover is not
enabled.\n

Logged every 5 minutes if the DEBUG logging is enabled

Failover
enabled

INFO: NNM Appli-
cation Failover is ena-
bled. Checking if
active node has
changed.\n

Logged every 5 minutes

Failover
enabled

INFO: NNM Host-
name currently used
by NPS is: $nnm_cur-

Logged every 5 minutes. Displays current NNM hostname being
used by the NPS.

Page 15 of 97



iSPI Performance for Metrics Online Help
Administration Overview

Condition Message Comments

rent\n

Failover
enabled

INFO: $getN-
NMActiveScript
reports active nnm
node is: $nnm_
active\n

Logged every 5 minutes. Displays NNM hostname reported as the
active node in the cluster.

Failover
enabled but
the active
host has not
changed.

INFO: Active NNM
host is unchanged.\n

Logged every 5 minutes.

Failover
enabled

INFO: Changing NPS
configuration to use
$nnm_active\n

A configuration update is imminent. This message is logged only
when the active node is different from the node currently used by
the NPS.

Failover
enabled
and config
files suc-
cessfully
updated

INFO: Configuration
updated. Path to
NNM is now $ne-
wpath\n

Logged after the configuration file is successfully updated in
response to an application failover.

Failover
enabled but
the NNM
hostname is
not in the
path syntax

WARN: NNM Appli-
cation Failover is not
supported on same-
system NNM/NPS
installations\n

If the NPS is running on the same machine as NNN, the path does
not contain the hostname.

Failover
enabled but
the NNM
hostname is
not in the
path syntax

WARN: Cannot
extract remote nnm
hostname from value
of PRSPI_NNMDIR
($cfg{PRSPI_
NNMDIR})..\n

The user may have specified the path in a non-conventional way
(for example, by using a hard mount or drive mapping). If the path
does not contain the remote NNM hostname, the NPS will not be
able to detect application failover.

Failover
enabled but
the NNM
hostname is
not in the
path syntax

WARN: Expected
PRSPI_NNMDIR of
form /net/hos-
tname/var... or //ho-
stname/PerfSpi\n

The user may have specified the path in a non-conventional way
(for example, by using a hard mount or drive mapping). If the path
does not contain the remote NNM hostname, the NPS will not be
able to detect application failover.

Failover
enabled but

the nnm_
details.xml
file is not
available.

ERROR: nnm_
details.xml not found

in $newpath

This message is logged is there is no copy of nnm_details.xml on
the remote NNM machine. This condition will occur if the nnmen-

ableperfspi script was not run on that machine, since running the
script is what creates the nnm_details.xml file. This condition could
also occur if the machine configurations are not identical. For
example, if the pathnames to the shared drive are not identical, the
new path will be incorrect when the NPS substitutes the new host-
name into the path. The configurations must be identical.
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Condition Message Comments

Failover
enabled but
there is a
file per-
missions
error

ERROR: Unable to
modify timestamp of
$newpath/nnm_
details.xml: $!.

The NPS configuration will not change; a file permissions error is
preventing the nnm_detail.xml file from being modified on the
NNM server.

Failover
enabled but
unable to
update the
config file.

ERROR: Unable to
write changes to con-
fig file. Will try again
next time.\n

Failure to update the config file could be caused by another proc-
ess that is locking the config file.

Time Changes and Time Zones

Semi-Annual Clock Changes

If you turn clocks back one hour, statistics for one hour will be recorded twice, once before the time
change, and once immediately after the time change. Collecting statistics twice for the same hour will
double the number of counts (volume in bytes, volume in packets) and double the number of samples
aggregated into an average. If you turn clocks ahead one hour, a gap will occur, since no samples will
be collectable for the missing hour. Counts for that hour will be zero, and counts for the whole day will be
artificially low.

Time Zones

NNM marks performance data with a universal time stamp known as seconds since epoch. The NPS con-
verts NNM's universal time stamp into local time, as defined by the location of the NPS. From the per-
spective of a user in a different time zone, NPS data will be out of sync with the local time.

If the NPS and the NNMi management server are running on separate systems, make sure that the sys-
tem clocks are matched. Otherwise confusion will arise as you move from one application to the other.

Overview of NPS Utilities

The NPS provides several utilities. Follow the links below to read more about each one.

l Log File Analyzer

l Log File Monitor

l Configuring the NPS

l Configuration Checker

l BI Server Portal

l Collecting Diagnostics for Support

l Resetting the iSPI

l Demo Data

l Backup and Restore

Analyzing Log Files

Use the Log File Analyzer to view:

l A daily summary of errors, warnings, and other notifications produced by each process within each
extension pack
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l Timing data for selected processes belonging to each extension pack

l Timing data for generating reports from the Report Menu

The Log File Analyzer tool analyzes the prspi.log and PerfSPI_Diagnostic_Metrics.log files.

How to Launch

Windows

Select Start > All Programs > HP > NNM iSPI Performance > Log File Analyzer

Linux

1. Go to the following directory:

/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:  
./log_analyzer.ovpl

Warnings, Errors, and Other Notifications

The summary data for warnings, errors, and other notifications covers the previous two weeks. The last
summary covers today. Today's summary will be incomplete until midnight. Summary data indicates:

l Date

l Number of errors per process, if any

l Number of warnings per process, if any

l Number of processes with fatal errors, if any

For example:

prspi.20080729.log:

WARN - 240 in ETL.Component_Health

WARN - 268 in ETL.Interface_Health

WARN - 285 in MainServiceLoop

ERROR - 2 in MainServiceLoop

prspi.20090915.log:

WARN - 27 in ETL.Interface_Health

WARN - 714 in MainServiceLoop

FATAL - 1 in Utility.startBI

FATAL - 152 in ETL.Interface_Health

FATAL - 1 in Utility.installExtensionPack

A warning normally indicates a transient condition, usually a temporary mismatch, that will self-correct. If
you see a warning message or a fatal error message, you may want to examine it in more detail by view-
ing the associated logfile in a text editor.

The last log in the list of logs is today's partially complete log. Today's partially complete log does not
have a date attached to it. The file name for today's log is just this: prspi.log

Timing Data

Under the summary of all warnings and errors, if you press Enter, you can continue to see the timing
data.

The timing data shows:
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l Total number of times a process executed over the previous two weeks

l Average execution time per process over the previous two weeks and standard deviation

l Maximum execution time per process over the previous two weeks

l Average number of records processed per execution

l Average number of records processed per second

Log File Monitor

The log file viewer is Chainsaw 2.0. With Chainsaw, you can monitor DEBUG, INFO, WARN, ERROR,
and FATAL messages as they reach the prspi.log file. The perfspi.log file contains every message
generated since the last night at midnight. The path to prspi.log is:

Windows

<Data_Dir>\NNMPerformanceSPI\logs

Linux

/var/opt/OV/NNMPerformanceSPI/logs

How to Launch

Follow these steps to launch the log file monitor:

Windows

The log file monitor is a start menu option. Select:

Start > All Programs > HP > NNM iSPI Performance > Log File Monitor

Linux

1. Go to the following directory: /opt/OV/NNMPerformanceSPI/bin

2. Type the following command:  ./runChainsaw.ovpl

The Chainsaw Message Interface

The welcome page includes several tabs. To open the message interface, click this tab:

NNMPerformanceSPI/logs/prspi.log

The Chainsaw message interface opens, showing three panes:

l Event pane - top center

l Detail event pane - below the Event pane

l Tree logger pane - to the left of the Event pane

The event pane is constantly changing, showing the most recent message, as it arrives in prspi.log, and
also showing additional information about that message in the detail event pane. The detail event pane
indicates the following:

l Level

l Logger

l Time

l Thread

l Message

l NDC [null]

l Class [not used]

Page 19 of 97



iSPI Performance for Metrics Online Help
Administration Overview

l Method [not used]

l Line

l File

l Properties

l Throwable [not used]

If you select an older message in the event pane, the detail event pane will refresh with additional infor-
mation about the message you just selected. The logger tree pane shows the following folder:

Root Logger

The ETL folder, which belongs under the Root Logger folder, contains three loggers folders; one for each
standard extension pack. If additional extension packs are installed (such as custom poll packages),
additional loggers appears (one additional logger for each new package).

New messages generated by the loggers appear once in every few seconds in the event pane. If you
want to see messages for one logger only, type that logger name in the Refine focus on field. For
example:

Refine focus on: Interface_Health

You may expand the event pane by closing the logger tree pane and the detail event pane. Following is
a partial list of Chainsaw version 2.0 features:

l Fully customize each tab the way you want it

l Control the frequency of updates

l Specify your own rules for color-coding events (the defaults are yellow for WARN, red for ERROR)

l Apply simple filters, or advanced expression-based filters

l Save memory by setting a cyclic-based view that looks at X events only

For more information about Chainsaw, run the tutorial under the Help menu or visit:

http://logging.apache.org/chainsaw/quicktour.html

Configuring the NPS

If you install the NPS on the NNMi management server, NPS configuration takes place automatically dur-
ing the installation.

If you install the NPS on a dedicated server, you must use the Configuration Utility to specify con-
figuration details. During installation, the Configuration Utility opens and asks you necessary con-
figuration details. After installation, you can anytime launch the utility to change the configuration data.

How to Launch

Windows

The Configuration Utility is a Start menu option. Open the Configuration Utility by selecting:

Start > All Programs > HP > NNM iSPI Performance > Configuration Utility

UNIX

1. Go to the following directory:

/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:
./runConfigurationGUI.ovpl
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Using the Configuration Utility

When the utility opens, you can specify the following details:

l User account details: Not required when you install the NPS on an Linux system and NNMi is
installed on a UNIX or Linux system. The Configuration Utility enables you to specify the details of
the system user account that enables the NPS to run necessary services.
If you install the NPS on the NNMi management server (Windows), you must set this to the Local Sys-
tem account.
If you install the NPS on a dedicated Windows system, you must select the Named User account
option. Make sure you specify exactly the same account information that was used with the ena-
blement script on the NNMi management server.

l Path to the NPS datafiles folder: Specifies the location of the NPS data files on the NNMi man-
agement server.
If you install the NPS on the NNMi management server, a local path is displayed in this field, which
you must not change.
When you install the NPS on a dedicated server, the enablement script creates a shared space on
the NNMi server. In this field, you must specify the location of shared space in the correct format.

l Detailed data archive retention period: Specify the archive table retention period (the default is 14
days; the maximum retention period is 70 days).

l Stop and Start buttons: You can use the Stop and Start buttons to stop and start necessary NPS
processes. 

To make any of these changes to configuration parameters:

1. Click Stop.

2. Make your change.

3. Click Apply.

4. Click Start.

5. Click Exit.

Configuration Checker

You can easily verify proper configuration of the NPS by launching the Configuration Checker. The Con-
figuration Checker verifies that the configuration file contains valid entries. If everything is okay, the fol-
lowing text displays:

INFO: Configuration File Validated OK

How to Launch

Windows

Select Start > All Programs > HP > NNM iSPI Performance > Configuration Checker

UNIX

cd to the following directory:/opt/OV/NNMPerformanceSPI/bin

Type the following command: ./checkConfig.ovpl

BI Server Portal

Use the BI Server Portal to accomplish these tasks:

1. Access reports from BI Server Connection.

2. Open My Reports and view reports with various filter preferences that you saved.

3. Set up a schedule for running summary reports.
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4. Modify BI Server tuning parameters for large multi-user installations.

5. Set up email report delivery.

How to Launch

Windows

Select Start > All Programs > HP > NNM iSPI Performance > BI Server Portal

UNIX

cd to the following directory:/opt/OV/NNMPerformanceSPI/bin

Type the following command: ./launchReport.ovpl

Web Access

Point your browser at:

http://<localhost>:9300/p2pd

When the login page opens, type your ErsAdmin username and password.

BI Server Welcome Page

Launching the BI Server Portal utility opens the BI Server 8 Welcome page. The content of the welcome
page varies according to role. An administrator sees the following options on the welcome page:

l View BI Server content (use BI Server Connection to access reports)

l Query your data (use Query Studio to create simple queries and reports)

l Analyze your data (use Analysis Studio to explore data dimensions and data hierarchies)

l Create reports (use Report Studio to create advanced reports)

l Manage events (use Event Studio to detect events, invoke tasks, and track events)

l Manage BI Server content (use BI Server Connection to search content, select output formats, set
schedules, email content, and manage saved output versions.)

To access reports, click BI Server Connection. The BI Server Connection window opens, showing two
tabs:

l Public Folders

l My Folders

Click Public Folders to display the following folders for available extension packs.

Collecting Diagnostics for Support

If you want to collect diagnostic data for Support, run the Diagnostics Collector utility. Support will use the
data you supply to diagnose the problem.

How to Launch

Windows

Start > All Programs > HP > NNM iSPI Performance > Diagnostics Collector

Linux

1. Go to the following directory:

/opt/OV/NNMPerformanceSPI/bin
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2. Type the following command:

./collectDiagnostics.ovpl

After collecting data, the Diagnostics Collector saves the output in the form of a compressed tar.gz file.
The path is:

Windows:

<Data_Dir>\HPNNMPerformanceSPI\collectDiag

UNIX:

/var/opt/OV/HPNNMPerformanceSPI/collectDiag

Forward the tar.gz file from the collectDiag folder to Support.

Resetting the NPS

The reset utility provides four options:

1. Delete all data from database and keep all archived data 

2. Delete all data from database and restore archived data for re-processing 

3. Delete all data from database and delete all archived metrics/topology 

4. Delete all data from database, delete all archived data and log files, and then restart all services

How to Launch

Windows

Select Start > All Programs > HP > NNM iSPI Performance > Reset Utility

Linux

1. cd to the following directory:/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:  ./resetSPI.ovpl

Demo Data

The demo database is part of the NPS. The NPS installation places the demo database on the system. If
you want to view reports using the demo data, you must enable the demo database.

Enabling the demo database does not disrupt any the ongoing data collection process of the NPS. When
you disable the demo database, the NPS begins building reports using the real network data.

How to Launch

Windows

To enable the demo database, Select Start > All Programs > HP > NNM iSPI Performance > Demo
Data Enable.

To disable the demo database, Select Start > All Programs > HP > NNM iSPI Performance > Demo
Data Disable.

Linux

To enable the demo database, go to the /opt/OV/NNMPerformanceSPI/bin directory, and then run

the following command:

./demoData.ovpl enable
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To disable the demo database, go to the /opt/OV/NNMPerformanceSPI/bin directory, and then run

the following command:

./demoData.ovpl disable

Backup and Restore

The NPS provides you with command-line tools to back up and restore all the NPS data.

To back up the NPS data:

1. Log on to the NPS system with the same account that was used to install the NPS.

2. Run the following command:
On Windows: <Install_Dir>\NNMPerformanceSPI\bin\backup.ovpl -b <dir> [-c] [-d] [-
f] [-v]
On UNIX or Linux: <Install_Dir>/NNMPerformanceSPI/bin/backup.ovpl -b <dir> [-c] [-d]
[-f] [-v]

In this instance, <dir> is the location where you want to place the backed-up data. Do not use <Install_
Dir> or <Data_Dir> with this option.

Options

l Use the -c option to back up contentstore.

l Use the -d option to backup the database.

l Use the -f option to backup all NPS files.

l Use the -v option for verbose output.

You must specify a valid directory location as an argument of the -b option. If you do not specify any
other options, the backup script by default backs up contentstore and the database.

The duration of the backup process depends on the size of the database you want to back up. Before
you start the backup process, verify the disk space used by the data that you want to back up, and then
make sure the system has as much available free disk space. Although the script produces compressed
output, the backup process requires sufficient temporary disk space.

To restore the NPS data:

1. Log on to the NPS system with the same account that was used to install the NPS.

2. Run the following command:
On Windows: <Install_Dir>\NNMPerformanceSPI\bin\restore.ovpl -b <file> [-v]
On UNIX or Linux: <Install_Dir>/NNMPerformanceSPI/bin/restore.ovpl -b <file> [-v]

In this instance, <file> is the backup file that you want to restore. You can use the -v option for verbose
output. The restore operation overwrites all the preceding NPS data.

Note: If you change the password of the database after a backup operation, you have to change it again
after restoring the backed-up database.

Page 24 of 97



iSPI Performance for Metrics Online Help
Using Reports

Using Reports

The NPS generates different types of reports with the help of the data available in its repository (column-
based DBMS) and the rules defined in extension packs. Reports help you view the operational per-
formance of metrics over a period of time. The NPS also enables you to modify the default settings of a
report to view additional attributes related to the monitored element.

The NPS presents the following types of reports:

l Calendar: The Calendar report uses a traditional, calendar-style layout to show hourly statistics of
two metrics. When you open a report, you can view the statistics of two default metrics. You can use
the options link to view the report for non-default metrics.

l Chart Detail: The Chart Detail report represents the actual values of two metrics at every display
grain over a period of time. You can use the options link to view the report for non-default metrics.

l Heat Chart: The Heat Chart (or the normalized Heat Chart) report represents the normalized values
of a metric, calculated at every hour of the day, in a tabular format. The NPS uses color codes to indi-
cate the performance characteristic of the metric in this report.

l Most Changed: The Most Changed report displays the quantum of changes that a metric has under-

gone during the selected time range. The report presents details like the percentage growth rate of
the metric.

l Top N: The Top N report displays the top ten values of the metric over the selected time range. In
addition, the report enables you to view the graphical representation of the top ten values.

l Dashboard: The Dashboard Report provides an overview of the network elements available on
your network by using a combination of gauges, heat charts, and ordered Top 5 lists. The focus of
the report is element-based threshold breaches, which are classed as exceptions. Threshold
breaches can point to a network-related problem or may indicate that your thresholds within NNMi
need to be changed.

l Headline: The Headline Report provides a broad view of performance by presenting eight different
graphs on a single page. This report enables you to view every aspect of performance at once. Use
the graphs to view trends, spot-isolated spikes, exceptions, and verify that performance is meeting
expectations.

l Managed Inventory: The Managed Inventory report lists the available topology attributes for the
extension pack with the available number of values for each attribute.

Launch Reports

You can launch reports created by the NPS or iSPI Performance products either from the Report Menu
page (introduced by the NPS), or you can use the BI Server portal.

To launch a report from the Report Menu page:

1. Log on to the NNMi console.

2. In the NNMi console, click Actions > Reporting-Report Menu. The Report Menu page opens.

3. On the Report Menu page, select a tab. The NPS presents the Self Diagnostictab for the default,
ready-to-use Self Diagnostic extension pack (to generate reports on the performance of the
NPS itself). Depending on the number of the iSPI Performance products or extension packs avail-
able on the NPS system, you may see many other tabs.

4. Under a report type (like Chart Detail or Heat Chart), select the time range link (H, D, W, or M). The
report for the selected time range opens.
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Tip: On the NNMi Network Overview workspace, if you select a node, and then click Actions > Reporting-
Report Menu, the Report Menu page presents reports created with the data collected from the
selected node.

Note: If you want to navigate back to the NNMi console, go to the Network Topology tab on the Report
Menu page, and then click NNMi Console. The Network Topology tab provides dynamic links to go
back to NNMi workspaces depending on the topology objects currently selected in the NPS.

Change Default Settings

The NPS generates reports with a set of parameters, which are set when you launch a report from the
Report Menu page or the NNMi console. Every NPS report is built with the following sets of parameters:

l Time controls

The time controls help you set the time range for the report that you want to view. The NPS database
stores the data collected from different nodes over a period of time. By using the time controls param-

eters, you can view a report created for the range of time of your choice. You can also select the dis-

play grain1 of a report. When a report is rendered, the time range is always shown in the Filter

Summary section at the top of the report.

l Topology filters

The topology filters enable you to create a report that is filtered, or constrained in scope, by specific
topology attributes. By default, when you launch a report for the first time from the Report Menu
page, the NPS generates the report that is not filtered. However, you can select a specific node or a
set of nodes from the NNMi console (from the Topology Maps workspace), and then launch the
Report Menu page to view reports only on the selected nodes. The topology filters extend this
capability by offering a range of filters on the Report Menu page, which help you select the data to
be included or excluded prior to viewing the report. When a report is rendered, the selected filters
are always shown in the Filter Summary section at the top of the report.

l Report options

Reports display graphical and statistical representation of different operational characteristics of the
network being managed. These characteristics are represented with metrics—parameters that indi-
cate the health and operational performance of the network. While every report opens with the
default metric set, the report options help you generate the report with the metrics of your choice.

Change Time Controls

When initially launched from NNMi, the Report Menu page offers you the following different time ranges
for every report—hour (H), day (D), week (W), and month (M). When you launch a report from the Report
Menu page, the report shows representation of data collected over the selected range—relative to the
most recent sample of data.

To change time controls:

1. Launch the report from the Report Menu page.

2. Click Time Controls. The Time Controls section appears.

1The display grain defines how samples of data are grouped across the time range. For example, a one
hour chart with a display grain of five minutes displays 12 samples of data.
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3. Change the following parameters:

n Start Date/Time: The Start Date/Time defines the point of origin of the report. The report shows
the data collected from the time and date specified in the Start Date/Time field.
The Start Date/Time is automatically set if you choose a relative time range (for example, Last
1 Hour, Last 1 Day, and so on). However, you can also set the Start Date/Time explicitly, in con-
junction with a non-relative Time range (for example,1 Hour, 1 Day, and so on)

To change the start date, click . A calendar opens. Select the date of your choice from the
calendar.

To change the start time, click or .

n Time Range: You can set the time range of the report in the Time Range box. You can select a
fixed time range after setting Start Date/Time (for example, 1 Hour), or select a range of time rel-
ative to the most recent sample of data available on the system (for example, Last 1 Hour). If
you select Until Now, the report displays the data collected from the specified time and date (in
the Start Date/Time field) until the last polling cycle.

When you set the time range, the display grain1 is automatically mapped to an appropriate

predefined setting. You can manually alter the display grain in the Display Grain box. How-
ever, too many data points on a chart can make the results difficult to read, and result in longer
running reports that consume a significant amount of resource. The NPS database retains the
data at grains of Hour and Day for 70 days, while the data at finer grains is retained for the
number of days specified by the Detailed Data Archive Retention Period setting (adjusted with
the Configuration Utility).

n Auto Refresh: The report gets automatically refreshed with the fresh samples of data if you
select an auto refresh rate with a relative Time Range (for example, Last 1 Hour) in the Auto
Refresh box.

n Hour of Day:To create a report with the metric values limited to specific hours of the day (for
example, morning shift, night shift), use the Hour of Day box. For multiple selection, select the
appropriate day from the list, and then hold the Ctrl button to select each additional hour.

n Day of Week: To create a report with the metric values at specific days of the week (for exam-
ple, weekdays only, weekends only, and so on), use the Day of Week box. You should use this
option only when the time range of the report is greater than a day. For multiple selection,
select the appropriate day from the list, and then hold the Ctrl button to select each additional
day.

4. Click Confirm Selection. The modified report appears.

Time Ranges with Default Display Grains

When you set a time range for a report, a predefined display grain is applied to the report. The following
table shows the mapping between the time ranges with the default display grains.

Time Range Display Grain

31 Days 1 Day

7 Days 1 Day

1The display grain defines how samples of data are grouped across the time range. For example, a one
hour chart with a display grain of five minutes displays 12 samples of data.
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Time Range Display Grain

1 Day 1 Hour

12 Hours 1/2 Hour

2 Hours 5 Minutes

1 Hour 5 Minutes

30 Minutes 1 Minute

15 Minutes 1 Minute

5 Minutes As Polled

1 Minute As Polled

Until Now Adjusted appropriately based on Start Date/Time

Your choice of display grain defines the data source for the reports.

The following three types of data sources exist within NPS:

l Internal Summary tables (data for up to 70 days)

l Internal Live tables (data for up to 1 day)

l Archive tables (data for up to ‘N’ days as set by the Configuration Utility)

Using a display grain of 1 hour or above ensures your reports will source their data from the Internal Sum-
mary tables. Using a display grain of less than 1 hour, combined with a Start Date/Time within the last
day, will result in the Live tables being used. Using a display grain of less than 1 hour, combined with a
Start Date Time prior to the last day, will force the NPS to use the Archive tables to fulfil the query. In this
last case, a warning message informs you that the report might be relatively slower, as it must perform
more expensive and time-consuming database query to retrieve the data.

Special Scenarios

l Start Date/Time and Time Range extend beyond the available data: The Start Date and Time auto-
matically shift to allow the requested Time Range to be selected from the available data set.

l Start Date/Time requested is prior to the oldest data: If you request a Start Date/Time that is prior to
the oldest data in the NPS, the Start Date and Time shift to coincide with the oldest data available.
The Time Controls section notifies you of this after you make the selection.

l Start Date/Time is not on the boundary of the display grain: Graphs and charts always show data

grouped into sample sets—the sample size is defined by the display grain1 . If the Start Date/Time is

not on the boundary of a display grain-sized sample, results can look unusual. The NPS always
attempts to round down the Start Date/Time to the beginning of the nearest display grain-sized sam-
ple.

For example: a Start Time of 12.15 am and a Time Range of 1 Day will have a default Time Grain of 1
Hour—resulting in 24 samples. However, the samples for the hour representing 12.00 will only have

1The display grain defines how samples of data are grouped across the time range. For example, a one
hour chart with a display grain of five minutes displays 12 samples of data.
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data from 45 minutes and will appear unusually low. To correct this, the Time Control will move the Start
Date/Time back to begin at 12.00 am automatically.

Adjust Time Ranges

The Adjust the time range icons provide convenient shortcuts to help you navigate to a different time
range of a report. When you modify the time range of the report with the Adjust the time range icons, the
NPS automatically assigns a Start Date/Time or suitable display grain for the report.

To adjust the time range of a report:

1. To display a shorter time span on the report, click (Adjust time- zoom in). The report shows the
data for the time range that is adjacent to and smaller than the original time range. Start time and dis-
play grain are automatically adjusted.

2. To display a wider time span on the report, click (Adjust time - zoom out). The report shows the
data for the time range that is adjacent to and larger than the original time range. Start time and dis-

play grain are automatically adjusted.

3. To shift the start time of the report, click or . The origin of the report shifts along the time axis
(X-axis).

Set Topology Filters

The NPS generates reports created from different metrics that are polled from different nodes, interfaces,
and other network elements. If you want to modify the report to contain data polled from select network
elements, you can use the Topology Filters section. The Topology Filters section enables you to filter and
generate reports on network elements with specific topology attributes.

All topology attributes shown in the list are obtained from NNMi or the collectors and pollers of iSPIs that
you are using. You cannot add new attributes or delete existing attributes from this list. The NPS pre-
serves the historical integrity of topology data such that any changes made to topology attributes (such
as Interface Speed, ifAlias values, and so on) are not retroactively applied to the existing historical data,
but only to new data.

Note: The Self Diagnostic tab displays reports on different NPS processes with the data collected from
the NPS server. Therefore, you cannot see any node or interface-related attributes in the Topology
Filters section of any Self Diagnostic reports.

To use Topology Filters:

1. Click Topology Filter. The Topology Folder section appears with the list of topology attributes.

2. Do one of the following for the topology attributes that you want to filter:

n If you want to select just one value for a topology attribute, click , and then select a value of
your choice.

n If you want to select multiple values, click , and then select values of your choice (by using
Ctrl-click or Ctrl+Shift).

n If you want to search and select a value from a list of values, click .

3. If you want to apply different types of topology filters, click Apply, and then repeat step 3 . Clicking
the Apply button suppresses the values from the other topology attributes that are irrelevant in the
context of the selection that you have already made. To discard your selection, click Reset.

4. Click Confirm Selection. The NPS generates the report with the data specified.
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Note: Cookies are used to preserve your preferred method of selecting each topology filter. For example,
if you open a ‘single value selector’ for an attribute, the next time you run a report, the single-valued
selector will already be opened. Do not open more selectors than you routinely use as they do add
some overhead (extra time) to running the report.

Tip: You can also select the ‘NOT’ check box ( ) if you want to exclude selected objects from the report.

Change Report Options

The Options link enables you to further customize the report with additional options that vary by report
type. The link provides you with the ability to select the metrics that are displayed on the report.

To change Report Options:

1. Launch the report from the Report Menu page if not already launched.

2. Click Report Options. The Report Options section appears.

3. Change the following settings:

n Metrics: A report displays the graphical or tabular representation of metrics associated with

the monitored element. Most reports open with the data for a default set of metrics, which you
can change with the help of the Primary/Secondary Metrics or Metrics box.

n Grouping By: Available only with select reports. In the Grouping By box, select an attribute to
define the grouping mechanism for the tabular data on the report. To select more than one

attribute, click . A new Grouping By box with the list of attributes appears. To remove a

grouping attribute, click .

n Top/Bottom N: Available only with the Top N report. The Top/Bottom N option helps you spec-
ify the number and order of data points for use with the Top N and Most Changed reports.

n Display Time Series Chart:Available only with the Top N report. The Display Time Series
Chart option enables you to view the time series chart at the bottom of the Top N report.

4. Click Confirm Selection. The modified report appears.

Note: Cookies are used to preserve your choice of metrics; when you come back to the report in the
future, the metrics that you selected the last time will be automatically used as the default metrics.

Use Links

The Show Links link appears on the top of every report. The Show Links link enables you to navigate to
related reports by preserving the time range, and if appropriate, the topology filter and metric settings
selected on the report page.

To launch related reports from the report:

1. If necessary, configure the default time controls, topology, and metric settings.

2. Click Show Links. A new Report Links section appears above the report content. In the Report Links
section, multiple tabs represent links to all related reports. When you launch a report from one of the
links in this section, the resulting report appears with the settings configured in step 2.
You can launch a report from the same extension pack tab, or from a different extension pack tab. If
you launch a report from a different extension pack tab, only the relevant topology filters are pre-
served. Since metrics typically vary between extension packs, the selected metric cannot be trans-
ferred to the target report.
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3. To see the original report, click Hide Links.

4. Click here for an example.1

Note: You can launch reports for a different extension pack by using the Show Links link.

Contextual Navigation

The NPS adds contextual links on the report content to navigate to related reports. By clicking a hyperlink
on the report, you can navigate to related reports with the context of the original report.

To use the contextual navigation feature:

Move the mouse pointer on the report until it becomes a hand icon, and then click. The list of related
reports appears.

Report
Type Contextual Navigation Point

Calendar X-axis; opens report links for reports with the same Date/time context and the same pri-
mary metric.

Heat Chart l Hour of Day Row Header; opens report links for reports with the same Hour of Day
filter of the selected row.

l Day of Month Header; opens report links for reports with the same Date/Time filter of
the selected row.

l Data cell value; opens report links for reports with the same Hour of Day filter of the
selected row and the same Date/Time filter of the selected date.

Headline X-axis; opens report links for reports with the same Date/Time context and the same met-
ric.

Dashboard l Interface name from the Top 10 utilization, Response Time, or Discard charts; opens
report links for reports with the same topology filter to selected interface and the
same metric.

l Needles of the Exception Count gauges; opens report links for reports with the same
metric.

Top N Object name (for example, interface name or node name); opens report links for reports
with the same topology filter.

Contextual Navigation

1

a. Go to a tab for an extension pack.

b. Under the Chart Detail report type, select W. The Chart Detail report opens with the data for the
last one week.

c. On the Chart Detail report, click Options.

d. In the Report Options section, set the metric fields to non-default metrics, and then click Confirm
Selection.

e. Click Show Links. The Report Links section appears with tabs for all the available extension
packs. However, tabs display links to launch reports only on weekly data.

f. In the Report Links section, under Calendar, click W. The Calendar report opens with the data for
the last one week. On the Calendar report, you can see the graph is generated with the metrics
selected in step d.
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Report
Type Contextual Navigation Point

Most
Changed

Object name (for example, interface name or node name); opens report links for reports
with the same topology filter.

Note: You can launch a report from the same extension pack tab, or from a different extension pack tab. If
you launch a report from a different extension pack tab, only the relevant topology filters are pre-
served. Since metrics typically vary between extension packs, the selected metric cannot be trans-
ferred to the target report.

Create Bookmarks

The NPS enables you to create bookmarks for reports on the Report Menu page. These bookmarks
encapsulate all the selected settings (Time, filters, Options) and enable you to be able to quickly visit the
report. again from your browser. Bookmarks are also convenient for emailing and sharing reports.

Note: If you want the bookmark to open the report within the same time range as the original report, make
sure to select a non-relative time range (for example, Start Date/Time with ‘1 Hour’ and not ‘Last 1
hour’ as the time range). Otherwise, the report will show the most recent data.

To create a bookmark for a report:

1. Launch a report.1

2. Make modifications to the default settings report depending on your requirements
(see Change Default Setting).

3. Click Show Bookmark. A URL appears.

4. Only for Microsoft Internet Explorer. Click Add Bookmark. A bookmark to the report is automatically
added to the browser with a new entry to the Favorites list.

5. Only for Mozilla Firefox. Create a new bookmark by using the displayed URL.

The bookmarked URL retains all the properties of the report (retains all the modifications done in step 2).

Add URL Actions in the NNMi Console

After you generate a bookmark, you can create a new Actions menu item with the newly generated book-
mark, which enables you to launch the report of your choice directly from the NNMi console.

To add URL actions in the NNMi console to launch a report:

1. Generate the bookmark for the report of your choice.

2. In the NNMi console, select the Configuration workspace from the workspace navigation panel.

3. Select User Interface Configuration.

4. Navigate to the Menu Items tab.

1

a. In the NNMi console, click Actions > Reporting-Report Menu. The Report Menu page opens.

b. On the Report Menu page, select a tab. The NPS presents the Self Diagnostictab for the
default, ready-to-use Self Diagnostic extension pack. Depending on the number of the iSPI
Performance products or extension packs available on the NPS system, you may see many other
tabs.

c. Under a report type (like Chart Detail or Heat Chart), select the time range. The report for the
selected time range opens.
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5.
Click (New).The Menu Item form opens.

6. In the basics section of the Menu Item form, specify the following details:

n Menu Item Label: The name of the report that you want to launch.

n Unique Key: A unique identifier for the menu item. Type an identifier with the maximum of 80
characters. You can use alpha-numeric and period characters; do not use spaces and under-
line characters.To make sure that the value is unique, use the Java name space convention
while specifying this value. Include the Menu Item Label value as part of the unique key as
shown in the following example: com.<company_name>.nnm.menu.item.<menu_item_
label>.

n
Author: You can specify the default value Customer, or click to add a new author name
(for example: NPS).

n Parent Menu: Retain the default value—Actions.

n Ordering: Specify an integer between 1 and 100. The lowest number appears at the top of the
Actions menu; the highest number appears at the bottom.

n Prepend Separator: Selecting this option adds a horizontal line before the report menu item in
the Actions menu.

n Enable: Select this option to use the report bookmark.

7. Retain all other default settings in the Basics section.

8.
In the Menu Item Context tab, click (New). The Menu Item Context form opens.

9.
In the Basics section, click , and then click New Launch Action. The Launch Actions
form opens.

10. In the Launch Actions form, specify a name in the Name box, add the bookmark URL in the Full URL
section, and then click Save and Close.

11. Click Save and Close in the Menu Item Context form.

12. Click Save and Close in the Menu Item form.

13. Click Save and Close in the User Interface Configuration form.

Now you can launch the report from the Actions menu.

Related Topics:

Create Bookmarks

Viewing Different Report Formats

View Different Report Formats

Other than the web-based HTML format, the NPS enables you to view a report in the following additional
formats: PDF and Microsoft Excel.

To view a report in a non-HTML format:
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1. Launch a report.1

2. Click .

3. Do one of the following:

n For the PDF format, click View in PDF Format. A PDF version of the report appears in the same
browser window.

n For the Microsoft Excel format, click View in Excel Options, and then click View in Excel 2007
Format, View in Excel 2002 Format, or View in Excel 2000 Single Sheet Format. A Microsoft
Excel version of the report opens. Only select reports are suitable for this format.

Note: The XML and CSV formats are not supported.

Schedule Report Delivery

From the BI Server Portal, you can schedule the generation and delivery of reports. You can create
schedules to email or print a report, or you can save the report on the NPS system once in every interval.

You can modify the default settings of reports when you create schedules.

To create a schedule:

1. Open the Report Menu page.

2. Click BI Server. The BI Server Portal opens.

3. On the BI Server Portal, select an extension pack of your choice. The list of reports provided by the
extension pack appears.

4. Go to the row that includes the report of your choice, select the checkbox, and then click Copy ( )
on the toolbar.

5.
Select the My Folders tab, and then click Paste( ) on the toolbar.

6. Click Set properties( ) under Actions.

7. Specify a name for the report, and then click OK.

8. Click Schedule ( ) to open the schedule page.

9. On the Schedule page, make the following selections:

n Frequency: Select a frequency of your choice. The report generation will be scheduled with
the frequency specified in this section.

n Start: Specify the start time and date of the schedule.

n End: Specify the end start and date of the schedule.

1

a. In the NNMi console, click Actions > Reporting-Report Menu. The Report Menu page opens.

b. On the Report Menu page, select a tab. The NPS presents the Self Diagnostictab for the
default, ready-to-use Self Diagnostic extension pack. Depending on the number of the iSPI
Performance products or extension packs available on the NPS system, you may see many other
tabs.

c. Under a report type (like Chart Detail or Heat Chart), select the time range. The report for the
selected time range opens.
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10. In the Options section, select the Override the default values option, and then specify the following
details:

n Formats: You can choose one or more formats from the HTML, PDF, and Microsoft Excel for-
mats. The CSV and XML formats are not supported.

n Delivery: You can print the report, email the report, or save the report on the NPS system. If
you select email as the delivery mechanism, you must configure the BI Server with an email
server.

11. In the Prompt values section, select the Override the default values option, and then click Set.

12. Make the Time Controls, Topology Filters, and Options selections, and then click Finish.

13. On the Schedule page, click OK.

Note: If you want the scheduled output to be available to all users, instead of copying the report into My
Folders as recommended above, you can create a new folder (for example, Public Scheduled
Reports) under Public Folders, and then copy the reports there before scheduling. Creating and
Modifying the Public Folder content requires your user account to have the administrator access.

If you want to use the NPS to email reports, you must configure the BI Server to use an SMTP email
server.

To configure the BI Server to send emails:

1. Launch the BI Server Configuration GUI.

On Windows:
<install_dir>\NNMPerformanceSPI\bin\runBIConfigGUI.ovpl

On UNIX/Linux:
/opt/OV/NNMPerformanceSPI/bin/runBIConfigGUI.ovpl

2. In the Explorer pane, select Notification.

3. Specify appropriate values for the following fields:

n SMTP Mail server

n Account and password

n Default Sender

4. To test the connection, right-click Notification in the left pane, and then click Test.

5. Click File > Save.

6. Select Yes when prompted to restart the service NNM iSPI Performance BIServer.

Create Custom Reports with Query Studio

With the Query Studio feature of the BI Server portal, you can create custom reports with the metrics from
all available extension packs. You can combine metrics from all available extension packs while creating
a custom report.

Note: HP does not offer any support for custom reports.

To create new reports using multiple extension packs:

1. On the Report Menu page, click BI Server Portal.

2. On the BI Server portal, select All ExtensionPacks.

3. From the top-right corner of the page, click Launch > Query Studio. Query Studio opens.
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4. The available time granularities appear under a query subject Date/Time. Select a time range of
your choice. To select the time range, expand the query subject Date/Time in the left pane, right-
click the time range of your choice, and then click Insert. The time granularity appears in a column
in the work area. To delete a time range from the work area, right-click the column for the time range,
and then click Delete.

5. To add the topology context to the report, add topology attributes to the work area. The available
topology attributes appear under a query subject Topology Attributes. Right-click a topology attrib-
ute, and then click Insert. The attribute appears in a column in the work area. To delete an attribute
from the work area, right-click the column for the attribute, and then click Delete. Topology attributes
from all installed extension packs will be listed, but not all topology attributes will be applicable to
metrics from all extension packs. If you point the mouse arrow over a topology attribute, a tool tip
appears and shows the extension packs that support that attribute.

6. In the left pane, expand Topology Group. The list of topology groups associated with the selected
extension pack appears. You must select a topology group relevant for the metrics you plan to
select. To select a topology attribute, right-click a topology attribute, and then click Insert. The attrib-
ute appears in a column in the work area. To delete an attribute from the work area, right-click the
column for the attribute, and then click Delete.

Note: Certain attributes like the Node Group and Interface Group attributes are available in a sep-
arate group ( Topology Groups) in the left pane.

7. The Topology groups tree can be expanded to allow Groups supported by the installed extension
packs to be used in the report. Right-click a topology group name, and then click Insert. The attrib-
ute appears in a column in the work area. To delete the Group Name column from the work area,
right-click the column, and then click Delete. Topology groups from all installed extension packs will
be listed, but not all topology groups will be applicable to metrics from all extension packs. If you
point the mouse arrow over a topology group, a tool tip appears and shows the extension packs that
support that group.

8. In the left pane, expand Metrics. The list of available extension pack appears. Expand the extension
pack of your choice, expand the fact table that holds the data that you want create the report with,
right-click the metric of your choice, and then click Insert. The metric appears in a column in the
work area. To delete a metric from the work area, right-click the column for the metric, and then click
Delete.

9. Format the report with the toolbar in the work area.

10. Save the report.

11. You can view the report when you log on to the BI Server portal.

Note: For more detailed instruction on how to use Query Studio, you can use the online help that is
included in the Query Studio toolbar (the ? icon).

Fact Tables

The following three types of data sources exist within the NPS:

l Internal Summary tables (data for up to 70 days) 

l Internal Live tables (data for up to 1 day) 

l Archive tables (data for up to ‘N’ days as set by Configuration utility)
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Self Diagnostics

The Self Diagnostics extension pack monitors the health of the processes which function within the NPS.
You can easily investigate how the processes within the NPS are performing by looking at Self diag-
nostic reports.

The Self Diagnostics extension pack has six reports that monitor the health of the internal processes:

l Calendar

l Chart Detail

l Heat Chart

l Most Changed

l Top N

l Top 10 Task Duration

Monitor the Health of the NPS and Extension Packs

The reports generated by the Self Diagnostic extension pack helps you monitor the health and per-

formance of the processes that build up the core functionality of the NPS. The reports also help you mon-
itor the performance of different extension packs available on the NPS system.

The Self Diagnostic extension pack identifies every process on the NPS system as a task. Every task is
grouped under relevant task type, task category, and extension pack in the following order:

Task Categories

The NPS uses two broad categories to group all processes—ETL and Report Generation.

Task Types

Under the ETL category, the NPS groups relevant process under the following task types:

l build_groupcache_from_db

l build_topcache_from_db

l checkAggregates
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l process_group_dump_file

l process_metricsfiles

l process_metricsfiles->bulkload archive table

l process_metricsfiles->bulkload live table

l process_metricsfiles->preprocessing

l process_retention->aggregate table

l process_retention->live table

l process_retention->archive table

l process_retention->timeDimension table

l process_summary->Summary Child Proc

l process_summary->Summary Parent Proc

l process_topodump_file

Under the Report Generation category, the NPS groups relevant process under the following task types:

l Calendar

l Chart Detail

l Dashboard

l Headline

l Heat Chart

l Most Changed

l Managed Inventory

l Top N

Tasks

The NPS monitors and administers essential processes as tasks running on the NPS system. All such
processes are introduced by different extension packs on the system. The processes are named in the
following format:

extension_pack_name>.<task_category>.<task_type>

Metrics

You can use the Self Diagnostics reports to report on the following metrics:

l Process Time (time in seconds for the task to complete) 

l Number of Rows (applies to select tasks, such as ETL bulk loads, and so on) 

l Available System Memory – shows free memory (on Linux, free and cached) enabling you to see if
your system’s memory usage is increasing, causing available memory to decrease. Low available
memory can cause system performance to degrade.

l Available Disk Space – enables you to monitor your disk usage in the ‘Data Directory’ file system.
By plotting the Available Disk trend over time, you can see if your disk usage has reached a steady
state, or if you are on a trajectory to run out of disk space.
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Calendar Report

The Calendar Report uses a traditional, calendar-style layout to show hourly statistics for two metrics in a
single, extended graph spanning over multiple days.

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

The Calendar Report defaults to:

l Task Categories, Task Types, and Task Names= All

l Dates/Times = Last 31 days

l Primary Metric = Process Time (secs)(avg)

l Secondary Metric = Process Time (secs)(avg)

Note: By default, both the metrics of this report are set to Process Time (secs)(avg). You can set the sec-
ondary metric to another value to see two graphs on this report.

The default view shows data for the current month. Depending on how long the NPS has been collecting
data, you may have the option of looking at data for the previous 70 days if you use the option Until Now.

Use Case

Use this report to observe:

l gradual trends over time

l isolated spikes

l to verify that an abnormal condition has returned to normal

l to make comparisons

This report also reveals:

l Day of week patterns

l Hour of day patterns

Chart Detail Report

Use Chart Detail to go back in time, to a specific day, and examine sampled data for multiple metrics in
detail. You can also examine averages and maximums for multiple metrics, and compare sampled data
for any two metrics.

The following are the available filters in the Time Controls pane for Chart Detail Report:

l Start Date/Time

l Time Range

l Display Grain

l Hour of day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults
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The graph on this report tracks two metrics over the selected time period. Unless you modify the defaults,
Chart Detail defaults to the following:

l Task Categories, Task Types, and Task Names = All

l Primary metric = Process Time (secs)(avg)

l Secondary metric = Process Time (secs)(avg)

Note: By default, both the metrics of this report are set to Process Time (secs)(avg). You can set the sec-
ondary metric to another value to see two graphs on this report.

The Chart Detail report enables you to view the data in the tabular format as well. To view the table, click
Options, and then select Table. The Table appears instead of the chart. To view both the chart and the
table, click Options, and then select Chart and Table.

Heat Chart Report

The Heat Chart Report tracks the hourly performance of a single metric. The default metric is Process
Time (secs) (avg). The default time period is the last 31 days. Performance is color-coded, making it easy
to spot a condition that is gradually worsening and making it easy to distinguish satisfactory performance
from unsatisfactory performance.

The following are the available filters in the Time Controls pane for Heat Chart Detail:

l Start Date/Time

l Time Range

l Display Grain

l Auto Refresh

l Hours of Day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

The legend at the top of the report ties a range of normalized performance values to a particular color.
Any value within that range will get that color. Beneath the legend, each day of the month is listed left to
right, day 1 through 31. Down the side of the report is each hour of the day. Each cell inside the table is
color-coded and each cell inside the table indicates a specific value. You can move the mouse pointer
on a cell to view raw data.

The Heat Chart defaults to:

l Time Period = Last 31 days

l Hour of Day = All

l Day of Week = All

l Metric = Process Time (secs) (avg)
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This report tracks percentages. If you open Heat Chart from a report that is using a non-supported metric
(for example, Sample Count or Response Time) you will be told to open the report controls window and
select an alternate metric.

Most Changed Report

This report compares performance for two different (consecutive) time periods and ranks processes by
the amount of change. The sort order is most-changed to least-changed.

The following are the available filters in the Time Controls pane for Most Changed Report:

l Start Date/Time

l Time Range

l Auto Refresh

l Hour of day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

This report contains one table and provides data for one metric only.

Following are the columns in the table:

l Performance for the previous time period

l Performance for the selected time period

l Growth, expressed as a percentage increase

l Change

The Most Changed report defaults to:

l Dates/Times = Last Day (and the day before)

l Hour of Day = All

l Day of Week = All

l Rank Metric = Process Time (secs)(avg))

l Top N Option = Top 10

If you select a month, the report will compare two months (the month you selected and the prior month); if
you select a week, the report will compare two weeks (the week you selected and the prior week).

Top N Report

This report ranks processes, by the metric you select. Use this report to spot the process that performed
at the extremes. You can use this report to go back in time and investigate sampled data for process that
are exhibiting unusual utilization levels. The default metric is Process Time (secs) (avg).

The following are the available filters in the Time Controls pane for Top N Report

l Start Date/Time: Default value depends on the default Time Range and data available in the data-
base

l Time Range: Default is the last 1 hour
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l Hour of day: Default is All

l Day of Week: Default is All

The following are the available filters in the Report Options for Top N Report. You can select the appro-
priate parameter from the drop-down.

l Top/Bottom 'N'

l Grouping by - default is “ExtensionPack”

l Metric – default is “Process Time (secs) (avg)"

l Display Time Series Chart

n Select Yes to view the detail chart with the table

n Select No to hide the chart and display only the table

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

Top N Summary defaults to:

l Time Period = Last Day

l Hour of Day = All

l Day of Week = All

l Rank Metric = Process Time (secs) (max)

l Top/Bottom N = Top 10

In addition to changing the metric, and modifying the time period, you can also change the ranking
number using the below options:

l Top 5

l Top 10

l Top 25

l Bottom 5

l Bottom 10

l Bottom 25

By default, the report groups data by Qualified Component Name. You can select multiple grouping attrib-

utes by using the (Add New Grouping) button. Use the (Remove Grouping) button to remove a
grouping attribute.

Click Show Chart to display the graphical representation of the metric values for the components over
the selected time range.

Click Show Chart to display the graphical representation of the metric values for the components over
the selected time range.

Use Case

Check this report once a day to see which process may need special attention.
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Check this report periodically throughout the day to see which process are performing at the extremes
and may need special attention.

Top 10 Task Duration Report

The Self Diagnostics extension pack monitors the health of all the ETL and report generation processes
on the NPS system. You can easily investigate how the ETL processes and reports are performing by
using the Top 10 Task Duration Report.

This report monitors the Top 10 ETL and report generation processes and tracks the time taken by each
process during the selected time range.

To change the Time Controls defaults, see "Change Time Controls".

Managed Inventory Report

Use the Managed Inventory Report to view the list of available topology attributes. You can use the avail-
able attributes to filter the data of your interest and create a report that represents only the elements of

your interest. The report presents the list of attributes in the form of a table; the Count column of the table
indicates the number of entries for each attribute.

For the topology item Extension Pack, the Count column indicates the number of available extension
packs on the NPS system.

For the topology item Task Category, the Count column indicates the number of task categories created
by the NPS. This value is always two (ETL and Report Generation) irrespective of the number of the avail-
able extension packs.

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".
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Troubleshooting Tips

Click the appropriate link from the lists below to display its details :

NNMi console Action menu has no link to Reporting – Report menu

Does the BI Server have guidelines for tuning performance?

An error message says that NNMi is not polling one or more objects for performance data. What went
wrong?

If I leave a report, and return later, I see a login screen. Why?

I'm waiting too long for reports to display. What can I do to improve the run-time?

When I leave my browser open for a while, I lose my connection and I can't get logged in again.

Where can I find more information about polling?

Why am I being asked to log in again when I navigate from NNMi to a report?

Why are exception counts missing from reports?

NNMi console Action menu has no link to Reporting – Report menu

The NNMi console does not display the Reporting-Report menu item in the Action menu if you do not
completely (and successfully) run the enablement script. Follow the Installation Guide to run the ena-
blement script (nnmenableperfspi.ovpl) on the NNMi management server.

An error message says that NNMi is not polling one or more objects for per-
formance data. What went wrong?

This message has more than one cause. The most likely cause is that NNMi is not polling the specified
device, or devices, for performance data. To find out how polling is configured, go to the monitoring con-
figuration form in NNMi and look at the polling attributes. Examine the polling attributes for the device
and for any group the device belongs to. If the monitoring configuration details indicate that the device is
being polled, then the problem is probably a topology synchronization issue.

NNMi and the NPS share topology information. Most of the time this information is fully synchronized.
However, certain conditions will cause the iSPI's view of network topology to vary slightly from NNMi's
view of network topology. A lack of topology synchronization can occur when:

l NNMi is running discovery

l NNMi rediscovers an existing network

l NNMi is adding or removing nodes, interfaces, or groups from polling policies
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When these conditions occur, you will see:

l An error indicating that NNMi is not polling targeted objects for performance data

l "Unmanaged" next to nodes and interfaces in the Path Health report.

If I leave a report, and return later, I see a login screen. Why?

The NPS will force your browser to display a login window under the following circumstances:

l You are trying to access the NPS without being authenticated by NNMi

l You pointed your browser at the NPS without logging into NNMi first

l Your browser session has expired

Simply log in again to return to the NPS.

Does the BI Server have guidelines for tuning performance?         

BI Server has tuning performance guidelines for single-server systems and distributed systems. The iSPI
Performance is a single-system installation. When reading the BI Server documents about performance
tuning, ignore the text about distributed systems.

There are two parameters that are especially important:

l Maximum number processes for the Interactive Report Service

l Maximum number processes for the Batch Report Service

If you have a lot of concurrent users, you may need to allocate more server resources to processing que-
ries. Do that by resetting the maximum number of interactive services to 2 per processor. If you have fast
processors, you could set the maximum number of interactive services to 3.

For example:

You have a system with 16 processors.

2 processes * 16 processors = 32 interactive services.

I'm waiting too long for reports to display. What can I do to improve the
run-time?

If the run time seems longer than it should be, take these steps:

1. If the problem appeared suddenly, find out if a topology reset took place on NNMi.

2. If no reset took place, find out if one or more interface groups were recently added to performance
monitoring.

3. Create a report view with the desired prompts and schedule this report view to run on a regular
basis. Then view the scheduled output, or bookmark a URL to view the scheduled output.

4. Filters can improve report performance. A report on a specific node group is generally faster than a
report on All Nodes/Interfaces; the same logic applies to the time dimension.

5. Are too many users bogging down the system? If yes, enable more parallel BI Server processes. Fol-
low the recommendations in BI Server tuning guides.

6. Check hardware statistics, especially aggregate CPU usage. More CPUs may be needed. Verify
that disk speed is adequate. For large networks, a RAID5 8-spindle is recommended.

7. Check if memory is exhausted.
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8. Run the same report again. Data caching, which took place the first time you ran the report, will
decrease the run time the next time you run the same report.

When I leave my browser open for a while, I lose my connection and I can't
get logged in again.

The inactivity timeout setting for the NPS is one hour. If your browser is inactive for an hour, your session
will expire. If your session expires, the NPS will force you to log in again. The login window requires a
special administrator username and password.

To access the reports after exceeding the timeout limit:

1. Close the timeout login window.

2. Log into the NNMi console using the standard URL:
http://fully-qualified-hostname:port;/nnm

3. Navigate to the iSPI Performance report that you were using.

Where can I find more information about polling?

Performance polling has an impact on NNMi and it also has an impact on your network. If you enable
additional performance polling, NNMi will have to allocate a portion of its resources to handle the addi-
tional polling, and your network will have to accommodate an increase in SNMP traffic. So that system
and network resources are used wisely, not wasted, it is important to limit performance polling to the
devices you care about most.

Performance polling is enabled by the NNMi administrator. Follow these steps to locate applicable help
topics:

1. Launch the NNM console.

2. Click Help → Help for Administrators.

3. Select Monitoring Configuration.

If you want to create a new node group, this involves setting device-level filters. After you create the new
node group, you may want to use the group as a way to filter NNMi views, and you might also want to
add the node group as a filter to the iSPI element selection tree.

Creating node groups, and using the filter options, are NNMi administrator tasks. Follow these steps to
locate applicable help topics:

1. Launch the NNMi console.

2. Click Help → Help for Administrators.

3. Select Monitoring.

Why am I being asked to log in again when I navigate from NNMi to a
report?

When you launched the NNM console, you probably failed to use NNM's fully-qualified domain name
(FQDN).

Whenever you move from NNMi to the a report, account information is passed between your NNM login
session and the NPS using cookies in your browser. A function known as Single Sign-On (SSO) makes it
possible for you to move from NNM to a report without having to log in a second time.

For SSO to operate, the following conditions must be met:
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l The NNMi system and the NPS system must be configured with fully qualified domain names.

l You must use the fully-qualified domain in your browser (not "localhost" or the machine name minus
the domain) when you launch the NNMi console.

A fully-qualified domain name (FQDN) has this format:

http://fully_qualified_domain_name:port/nnm

If NNMi and the NPS are installed on the same machine, the SSO function will operate if you use either
of these:

l NNM's FQDN

l NNM's IP address

The NPS is responsible for configuring use of NNMi's IP address; this step takes place automatically,
when the NPS is installed.

Why are exception counts missing from reports

Reports will not track exception counts unless high and low thresholds are set in NNMi. If reports are not

showing exception counts, the NNMi administrator has not set thresholds.

If iSPI reports are not showing exceptions, then it is possible that network performance is still being eval-
uated and no one is in a position to set good thresholds.

How to set thresholds is explained in NNMi online help. Immediately after thresholds are set, exceptions
will begin to register in reports.

The NPS stops functioning and does not show any reports

After installing the NPS, if you modify the IP address, hostname, or MAC address of the NPS server, you
cannot restart the NPS server. As a result, you cannot view any reports. To resolve this, you must perform
additional configuration steps.

Before changing the IP address, hostname, or MAC address of the NPS server, follow these steps:

1. On the NPS server, run the following command:

On Windows:
<install_dir>\NNMPerformanceSPI\bin\stopAll.ovpl

On Linux:
/opt/OV/NNMPerformanceSPI/bin/stopALL.ovpl

2. Open the BI Server configuration GUI with the following command:

On Windows:
<install_dir>\NNMPerformanceSPI\bin\runBIConfigGUI.ovpl

On Linux:
/opt/OV/NNMPerformanceSPI/bin/runBIConfigGUI.ovpl

3. Click File > Export As.

4. Specify a location and a file name in the dialog box, and then click Save.The configuration data is
saved in the XML format.

5. Delete the following directories manually:

On Windows:
<install_dir>\nonOV\cognos\c8\configuration\signkeypair
<install_dir>\nonOV\cognos\c8\configuration\encryptkeypair
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On UNIX/Linux:
/opt/OV/nonOV/cognos/c8/configuration/signkeypair
/opt/OV/nonOV/cognos/c8/configuration/encryptkeypair

6. Copy the XML file saved in step 3 to the following directory:

On Windows:
<install_dir>\nonOV\cognos\c8\configuration

On UNIX/Linux:
/opt/OV/nonOV/cognos/c8/configuration

This problem does not appear if you change the IP address, hostname, or MAC address of the NPS
server after you perform step 1 through 6.

Errors and Warnings

Type Message Cause/Suggested Actions

WARN Attempting to extend allocated space for
DBSPACE {DB_SPACE} using dbsize.ovpl

The database requires additional disk
space; the ETL process will allocate
more.

WARN Attempting to restart HP BI Server Processes The BI server process has stopped
while ETL is running. ETL will attempt to
restart the process.

WARN Attempting to restart HP DB Server The database server process has
stopped while ETL is running. ETL will
attempt to restart the process.

ERROR Automatic NNM HA add-on configuration failed:
Exit Code {EXIT_CODE}

High availability configuration failed.

WARN BI Processes not running. The BI server process has stopped
while ETL is running.

ERROR BI Processes still not running.. restart attempt
failed.

The BI server process has stopped
while ETL is running. ETL has
attempted to restart the process but
failed to do so, and ETL cannot con-
tinue. Try starting the BI server process
manually using startBI.ovpl.

ERROR Cannot extract remote nnm hostname from value
of PRSPI_NNMDIR ({PRSPI_NNMDIR})

On a dedicated server installation, the
configuration entry for the NNMi shared
directory should contain the name of the
NNMi server. Failure to determine this
hostname affects application failover
configurations. 

ERROR Cannot find the OV Install Dir <{DIR}>. %nnminstalldir% does not exist. Check
the NNMi installation.
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Type Message Cause/Suggested Actions

ERROR Cannot find the nnm.ports.properties file to estab-
lish port for jboss http server.

If the jobs port cannot be determined
the iSPI cannot be enabled. Check the
NNMi installation. 

ERROR Check NNM HA environment then run nnmen-
ableperfspi.ovpl.

Enabling iSPI in an HA environment
must be done in a specific order. See
the HA-specific topic in the NNMi
Deployment Guide for more information.

ERROR Check your environment for NNM environment var-
iables then run nnmenableperfspi.ovpl.

Some or all required NNMi variables
cannot be determined. Check the NNMi
installation. 

ERROR Command Failed: {PERL} getNNMActiveScript:
{CHILD_ERROR}

An application failover specific script
has failed. Check your application fail-

over environment.

ERROR Command Failed: {UNZIP} {ZIPFILE}: {CHILD_
ERROR}

An error occurred unzipping the iden-
tified file. The CHILD_ERROR may give
more information (corrupt zip file, per-
missions issue etc.)

ERROR Command: {OVDIR}/misc/nnm/ha/nnm-
haclusterinfo.ovpl -config NNM -get HA_PERF-
SPI_ADAPTER_DIR

A high availability specific script has
failed. Check your high availability envi-
ronment.

ERROR Command: {OVDIR}/misc/nnm/ha/nnm-
haclusterinfo.ovpl -config NNM -get NNM_INTER-
FACE

A high availability specific script has
failed. Check your high availability envi-
ronment.

ERROR Command: {OVDIR}/misc/nnm/ha/nnm-
haconfigure.ovpl NNM -addon PerfSPIHA

A high availability specific script has
failed. Check your high availability envi-
ronment.

ERROR Configuration file contains errors. The iSPI configuration file contains
errors, check the associated error mes-
sages for specifics.

ERROR Configuration: Unable to access directory {PRSPI_
METRICS}

The shared directory for metrics is inac-
cessible. Check that NFS or Samba is
operating properly.

ERROR Configuration: Unable to access directory {PRSPI_
NNMDIR}

The main shared directory is inac-
cessible. Check that NFS or Samba is
operating properly.

ERROR Configuration: Unable to access directory {PRSPI_
TOPODUMP}

The shared directory for topology infor-
mation is inaccessible. Check that NFS
or Samba is operating properly.

ERROR Configuration: directory {PRSPI_METRICS} must
have write access

The shared directory for metrics is not
writable. Check your NFS or samba con-
figuration and file permissions.
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Type Message Cause/Suggested Actions

ERROR Configuration: directory {PRSPI_TOPODUMP}
must have write access

The shared directory for topology infor-
mation is not writable. Check your NFS
or samba configuration and file per-
missions.

ERROR Configuration: java not found in 'java_dir' ({java_
dir})

The HP Java installation appears to be
corrupted.

ERROR Configuration: perl not found in 'perl_dir' ({perl_
dir})

The HP Perl installation appears to be
corrupted.

ERROR Configuration: {NAME} not defined. A required configuration parameter is
not defined.

ERROR Configuration: {NAME} value must be a valid path.
Invalid value: {VALUE}

A required configuration parameter
must be a valid path and it is not.

ERROR Configuration: {NAME} value must be numeric.
Invalid value: {VALUE}

A required configuration parameter
must be numeric and it is not.

ERROR DB Processes still not running.. restart attempt
failed.

The database server process has
stopped while ETL is running. ETL will
has attempted to restart the process but
failed to do so. ETL cannot continue. Try
starting the database server process
manually using startDB.ovpl 

WARN DBSPACE {DBSPACE}, FILE {FILE}: Cannot
extend because there is no reserve space left.

The database needs to be extended but
cannot because there is no disk space
available. You should free existing disk
space or add new disks before your
database runs out of space.

WARN DBSPACE {DBSPACE}, FILE {FILE}: Cannot
extend {PATH} because there is insufficient disk
space left on file system.

The database needs to be extended but
cannot because there is no disk space
available. You should free existing disk
space or add new disks before your
database runs out of space.

WARN Database Processes not running! The database server has stopped while
ETL is running

WARN Dropping connection_id {CONNECTION_ID} The specified connection is being
dropped. This is normally a transparent
operation for report users.

WARN Error - Unable to remove the nnm actions for iSPI
for Performance

Check NNM is running. You can also
remove actions from the NNMi console.

WARN Error running dbisql: {DB_ERROR} ({SQL}) The described SQL error occurred.
Check for other messages associated
with this one.

Page 50 of 97



iSPI Performance for Metrics Online Help
Troubleshooting Tips

Type Message Cause/Suggested Actions

WARN Expected PRSPI_NNMDIR of form /net/hos-
tname/var... or //hostname/PerfSpi

On a dedicated server install the NNM
directory path should be one of the
forms shown.

WARN Extension Pack {EXTENSION_PACK}: process not
running. Restarting

An ETL process had to be restarted.

WARN Failed archiving logfile PerfSPI_Diagnostic_Met-
rics.log

The log archive process failed.

WARN Failed archiving logfile prspi.log The log archive process failed.

ERROR Failed building extensionPack for new or updated
NNM metadata: {METADATA}

This should not be encountered by cus-
tomers.

ERROR Failed chdir to {DIR}: {OS_ERROR} Failed changing directory to the spec-
ified directory, the OS error may give
more information (directory does not
exist, permissions etc.)

WARN Failed command:copy({FILE_LIST}):{OS_ERROR} Failed copying the specified files, the
OS error may give more information
(directory does not exist, permissions
etc.)

ERROR Failed command:copy({FILE_LIST}):{OS_ERROR} Failed copying the specified files, the
OS error may give more information
(directory does not exist, permissions
etc..) The program immediately exits. 

ERROR Failed command:fork():{OS_ERROR} Failed forking (creating a new process),
the OS error may give more information
(lack of system resource, etc..) The pro-
gram immediately exits. 

ERROR Failed command:mkpath({PATH_LIST}):{OS_
ERROR}

Failed creating the specified directories,
the OS error may give more information
(directory does not exist, permissions
etc..) The program immediately exits. 

WARN Failed command:mkpath({PATH_LIST}):{OS_
ERROR}

Failed creating the specified directories,
the OS error may give more information
(directory does not exist, permissions
etc..)

ERROR Failed command:move({FILE_LIST}):{OS_
ERROR}

Failed moving the specified files, the OS
error may give more information (direc-
tory does not exist, permissions etc..) 
The program immediately exits. 

WARN Failed command:move({FILE_LIST}):{OS_
ERROR}

Failed moving the specified files, the OS
error may give more information (direc-
tory does not exist, permissions etc..)
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Type Message Cause/Suggested Actions

ERROR Failed command:open({HANDLE},{ARGS}):{OS_
ERROR}

Failed opening the specified file, the
arguments and OS error may give more
information (directory does not exist, per-
missions etc..) The program imme-
diately exits. 

ERROR Failed com-
mand:open({HANDLE},{FLAG},{ARGS}):{OS_
ERROR}

Failed opening the specified file, the
arguments and OS error may give more
information (directory does not exist, per-
missions etc..) The program imme-
diately exits. 

WARN Failed command:opendir(DIR,{DIR Configuration:
{NAME} not defined.NAME}):{OS_ERROR}

Failed opening the specified directory,
the OS error may give more information
(directory does not exist, permissions
etc..)

WARN Failed command:system({COMMAND}:{CHILD_
ERROR})

Failed running the specified system
command, the OS error may give more
information (lack of system resources
etc..)

ERROR Failed command:system({COMMAND}):{CHILD_
ERROR}

Failed running the specified system
command, the OS error may give more
information (lack of system resources
etc..) The program immediately exits. 

ERROR Failed command:unlink({FILE_LIST}):{OS_
ERROR}

Failed removing the specified files, the
OS error may give more information
(directory does not exist, permissions
etc..) The program immediately exits. 

WARN Failed command:unlink({FILE_LIST}):{OS_
ERROR}

Failed removing the specified files, the
OS error may give more information
(directory does not exist, permissions
etc..)

ERROR Failed copying file from specified
source to destination, the OS error may
give more information (directory does
not exist, permissions etc..)

Failed copying {SRC} to {DEST}: {OS_ERROR}

ERROR Failed creating {FILE}: {OS_ERROR} Failed creating the specified file, the OS
error may give more information (direc-
tory does not exist, permissions etc..)
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Welcome to the iSPI Performance for Metrics

The iSPI Performance for Metrics enables the combination of NNMi and iSPI Performance to

produce rich and insightful reports from the network performance data collected by NNMi. With the

introduction of extension packs that add definitions to generate reports, the iSPI Performance for

Metrics presents you with ready-to-use report templates that offer meaningful representation of the

aggregated data gathered from NNMi.

The iSPI Performance for Metrics introduces the following extension packs:

l Interface health: Creates reports that help you examine the MIB II interface statistics.

l Component Health: Creates reports that examine memory, CPU, and buffer utilization.

l Path Health: Uses data from the other two sources—Interface Health and Component

Health—to create reports on network paths built with a combination of nodes and interfaces.

The iSPI Performance for Metrics removes most of the labor required to detect a network problem and
pinpoint the cause. The iSPI Performance for Metrics automates the following chores:

l Exception reporting

l Ranking

l Trending

Exception reporting highlights threshold conditions, providing an easy way to spot abnormal per-
formance. Ranking sorts elements by the metric of your choice and allows you to identify network ele-
ments with unusually high or unusually low values. If an element in the network is experiencing unusual
or extreme performance, ranking will make that element easy to spot. Trending looks at a period of time
and lets you see whether performance is stable, getting worse, or improving.

In addition to reporting exceptions, ranking elements, and displaying trends, the iSPI Performance for
Metrics lets you drill down on any aggregate of data until you isolate the node, interface, or component
responsible for the condition you are investigating. After you locate the element, you can drill down on
the time dimension as well and find out precisely when the condition started.

iSPI Performance for Metrics query features let you modify a report by applying filters to the network
dimension and the time dimension. Use the network topology filter to modify the report on a particular
node group or a particular node. Use time dimension filter to select a particular day, week, or month. In
addition, you can also filter data by day-of-week and by hour-of-day. Some reports let you replace the pri-
mary and secondary metric with any metrics you choose, and some reports let you modify the scope and
direction of ranking. For example, you can specify that you want to look at the Top 25 elements instead of
the default Top 10, and you can specify that you want to look at the Bottom 5 elements instead of the Top
5.

Component Health Reports

The Component Health reports show the performance data for network components in your environment.
Graphs and charts on Component Health reports reflect the details related to the following elements of
devices:

l CPU

l Memory

l Buffer

l SNMP response time

Use Component Health reports to determine if an interface is over-utilized or if it needs an upgrade.
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Opening Reports from NNMi

From the NNMi Console, you have these options:

Click the Reporting - Report Menu option under the Actions menu; launch reports from the Report
Menu.

Launch pre-filtered iSPI reports directly from NNM

If you are interested in a particular node group, node, or interface, you will probably want to launch a pre-
filtered report from NNMi; otherwise, open a workspace view from NNMi, move to the iSPI, and begin
your investigation from the Report Menu. To move from NNMi to the iSPI:

1. Log in to the NNMi Console.

2. Select a workspace.

3. Open a view (nodes, interfaces, components, or incidents).

4. Select Actions > Reporting - Report Menu page

Glossary of Metrics

Memory Utilization

Percentage of memory in use compared to the total amount of memory available.

l Memory Utilization (Avg%)

l Memory Utilization (Max%)

l Memory Utilization Exceptions (Avg%)

l Memory Utilization Exceptions (#samples)

Buffer Utilization

Percentage of buffer space in use compared to the total amount of buffer space available.

l Buffer Utilization (Avg%)

l Buffer Utilization (Max%)

l Buffer Utilization Exceptions (Avg%)

l Buffer Utilization Exceptions (#samples)

Buffer Miss Rate

A counter measures the number of buffers available in the buffer pool. An exception is recorded when
the number of buffers drops below a minimum number. The miss rate percentage shows how the number
of below-minimum samples compares to total samples.

l Buffer Miss Rate (Avg%)

l Buffer Miss Rate (Max%)

l Buffer Miss Rate Exceptions (Avg%)

l Buffer Miss Rate Exceptions (#samples)

Buffer Failure Rate

A counter measures the number of times buffer creation fails due to insufficient memory. An exception
occurs when the number of failures crosses a threshold. The buffer failure rate is a percentage that
shows how the number of buffer creation failures compares to the total number of buffer creations.
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l Buffer Failure Rate (Avg%)

l Buffer Failure Rate (Max%)

l Buffer Failure Rate Exceptions (Avg%)

l Buffer Failure Rate Exceptions (#samples)

l Buffer NoMemory Rate Exceptions (Avg%)

l Buffer NoMemory Rate Exceptions (#samples)

CPU Utilization

Percentage of CPU utilization in use compared to the total amount of CPU capacity available. (This met-
ric maps to the CPU 1m utilization value from NNM.)

l CPU Utilization (Avg%)

l CPU Utilization (Max%)

l CPU Utilization Exceptions (Avg%)

l CPU Utilization Exceptions (#samples)

CPU 5-Second Utilization

This metric averages CPU utilization over a 5-second period, providing a snapshot of the past 5-seconds
at the time of polling. Available from Cisco devices only.

l CPU 5s Utilization (Avg%)

l CPU 5s Utilization (Max%)

l CPU 5s Utilization Exceptions (Avg%)

l CPU 5s Utilization Exceptions (#samples)

CPU 1-Minute Utilization

This metric averages CPU utilization over a 1-minute period, providing a snapshot of the previous minute
at the time of polling. Available from Cisco and Nortel Passport devices.

l CPU 1m Utilization

l CPU 1m Utilization (Avg%)

l CPU 1m Utilization (Max%)

l CPU 1m Utilization Exceptions (Avg%)

l CPU 1m Utilization Exceptions (#samples)

CPU 5-Minute Utilization

This metric averages utilization over a 5-minute period, providing a snapshot of the previous 5 minutes at
the time of polling. Available from Cisco devices only.

l CPU 5m Utilization

l CPU 5m Utilization (Avg%)

l CPU 5m Utilization (Max%)

l CPU 5m Utilization Exceptions (Avg%)

l CPU 5m Utilization Exceptions (#samples)

Response Time

The time it takes a node to respond to an SNMP request from NNMi
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l Response Time (Avg msec)

l Response Time (Max msec)

l Period Length (sec)

SampleCount

The number of samples. Some nodes do not support the full range of metrics. To avoid skewing the aver-
ages, separate counts are kept for each metric received. 

l SampleCount (All)

l SampleCount (Memory)

l SampleCount (Buffers)

l SampleCount (CPU)

l SampleCount (Buffer Miss)

l SampleCount (Buffer Failure)

l SampleCount (Buffer NoMem)

l SampleCount (CPU5s)

l SampleCount (CPU1m)

l SampleCount (CPU5m)

NodeCount

The number of nodes polled.

ComponentCount

The number of components polled.

Reports

The Component Health extension pack presents the following reports:

l Calendar

l Chart Detail

l Heat Chart

l Most Changed

l Top N

l Managed Inventory

l Dashboard

l Headline

Calendar Report

The Calendar Report uses a traditional, calendar-style layout to show hourly statistics for two metrics in a
single, extended graph spanning over multiple days.

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

The Calendar Report defaults to:
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l Nodes/Components = All

l Dates/Times =Last 31 days

l Primary Metric (Yellow in the graph) = Memory Utilization (avg)

l Secondary Metric (blue in the graph) = CPU 5min Utilization – Exception Rate (max)

The default view shows the data for the current month. Depending on how long the iSPI has been col-
lecting data from NNM, you may have the option of looking at data for the previous two months as well as
last 31 days.

Note: If you set the Time Range below 24 hours, the following message appears:
This report is not designed to operate with a time range of less than 24 hours.
Please modify your time selections.

You can use the following Time Controls parameters:

l Start Date/Time

l Time Range

l Auto Refresh

Use Cases

Use this report to observe:

l gradual trends over time

l to spot isolated spikes

l to verify that an abnormal condition has returned to normal

l to make comparisons

For example, to compare the data of the last 31 days, or to compare data for last month to data for the pre-
ceding month.

This report also reveals:

l Day of week patterns

l Hour of day patterns

For example, if utilization is spiking on Tuesdays, or if response time issues are occurring daily at 11:00
a.m., the report will highlight these events.

Guided Tour - Component Health Calendar Report

The following image shows a typical calendar report for the components on your network:
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Chart Detail Report

Use the Chart Detail Report to examine sampled data for any two metrics in detail. This report contains a
graph representing data samples of two metrics.

You can use the following Time Controls parameters:

l Start Date/Time

l Time Range

l Display Grain

l Auto Refresh

l Hours of Day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

The graph on this report tracks two metrics over the selected time period. Unless you modify the defaults,
Chart Detail defaults to the following:

l Nodes/Components = All

l Primary metric = Memory Utilization (avg)
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l Secondary metric = CPU 5 min Utilization - Exception Rate (max)

The Chart Detail report enables you to view the data in the tabular format as well. To view the table, click
Options, and then select Table. The Table appears instead of the chart. To view both the chart and the
table, click Options, and then select Chart and Table.

Guided Tour - Component Health Chart Detail Report

The following image shows a typical Chart Detail report for the components on your network:

Heat Chart Report

The Heat Chart Report tracks the hourly performance of a single metric. The default metric is Memory Util-
ization (avg). The default time period is the last 31 days. Performance is color-coded, making it easy to
spot a condition that is gradually worsening and making it easy to distinguish satisfactory performance
from unsatisfactory performance.

You can use the following Time Controls parameters:

l Start Date/Time

l Time Range

l Display Grain

l Auto Refresh
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l Hours of Day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

The legend at the top of the report maps a range of normalized performance values to a particular color.
Beneath the legend, a table represents the normalized values of a performance metric (rows of the table
represent hours of the day; columns of the table represent days). Each cell inside the table is color-
coded and each cell inside the table indicates a specific value of the metric.

You can move the mouse pointer on the cell to see the raw data of each hour.

The Heat Chart defaults to:

l Nodes/Components = All

l Time Period = Last 31 days

l Hour of Day = All

l Day of Week = All

l Metric = Memory Utilization (avg)

While selecting the Time Controls parameters, you can choose the following values:

l A specific day other than Last Day

l A specific week this month (or partial week)

l A specific week in a previous month (or partial week)

l Last 31 days

l A previous month

Note: If you set the Time Range below 24 hours, the following message appears:
This report is not designed to operate with a time range of less than 24 hours.
Please modify your time selections.

This report tracks percentages. If you open Heat Chart from a report that is using a non-supported metric
(for example, Sample Count or Response Time), you will be told to open the report controls window and
select an alternate metric.

Use Case

Use the Heat Chart to identify:

l gradual shifts from one range of performance to another range

l to spot an isolated instance of poor performance that affected the results for one day

l to spot day-of-week or hour of day patterns

l to verify that an abnormal condition returned to normal after a problem was corrected

Guided Tour - Component Health Heat Chart Report

The following image shows a typical Heat Chart report for the components on your network:
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To view the actual value of the metric at a specific hour, point the mouse arrow toward the desired cell.

Most Changed Report

This report compares performance the components for two different (consecutive) time periods and ranks
components by the amount of change. The sort order is most-changed to least-changed.

You can use the following Time Controls parameters:

l Start Date/Time

l Time Range
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l Auto Refresh

l Hour of day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

This report contains one table and provides data for one metric only.

The table presents the following columns:

l Component

l Performance for the previous time period

l Performance for the selected time period

l Growth, expressed as a percentage increase

l Change

The Most Changed report defaults to:

l Grouping by Elements = Qualified Component Name

l Start Date/Time = Depends on default Time Range and data available in the database

l Time Range = Last 1 hour

l Hour of Day = All

l Day of Week = All

l Rank Metric = Memory Utilization (Avg%)

l Top N Option = Top 10

By default, the report groups data by Qualified Component Name. You can select multiple grouping attrib-

utes by using the (Add New Grouping) button. Use the (Remove Grouping) button to remove a
grouping attribute.

Use Case

Use this report to identify components that saw significant change from one time period to the next. Sig-
nificant change could point to a developing problem. The report shows the rate of change in the Growth
Rate column. You can change the ranking metric and you can change how many elements are listed.

Note: Since the Most Changed report compares performance in two continuous time periods, the “Until
Now” option for All Dates/Times is not a valid time period. Selecting “Until Now” for Time Range will dis-
play the following error:

This report does not operate with the current time interval. Please modify your selection.

Guided Tour - Component Health Most Changed Report

The following image shows a typical Most Changed report for the components on your network:
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Headline Report

The Headline Report provides a broad view of performance. This report enables you to view every
aspect of performance at once. You can use the graphs to view trends, identify isolated spikes, and verify
that performance is meeting expectations.

You can use the following Time Controls parameters:

l Start Date/Time

l Time Grain

l Display Grain

l Hours of Day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

Features and Defaults

The Headline Report contains the following graphs:

l Average Memory Utilization and Exceptions

l Average Buffer Utilization and Exceptions

l Average CPU Utilization and Exceptions

Note: The Headline report does not provide options to create graphs on other metrics.

The Headline Report defaults to:

l Components = All

l Time Period = Last 1 Hour
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l Hours of Day = All

l Days of Week = All

Use Case

This report shows the data for exceptions only if thresholds for performance metrics are set in NNMi. For
the set thresholds, if the performance exceptions occur, exceptions will appear as red stars in the range
graphs.

If you are viewing data for a single day, the metrics are aggregated to the hourly level. All other time peri-
ods show data aggregated to the daily level.

Guided Tour - Component Health Headline Report

The following image shows a typical Headline report for the components on your network:

Memory Utilization and Exceptions

Buffer Utilization and Exceptions

CPU Utilization and Exceptions
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Dashboard Report

The Dashboard report provides an overview of the components available on your network using a com-
bination of gauges, heat charts, and ordered Top 5 lists. The focus of the report is component-based
threshold breaches, which are classed as exceptions. Threshold breaches can point to a network-related
problem or may indicate that your thresholds within NNMi need to be changed.

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

Like all other reports, the Dashboard report includes a Time Control and a Topology Filter that enable
you to modify the time range displayed and the network elements whose data will be used to form the
report.

The Dashboard report also includes a Group By option. You can group the data within the report using
the grouping option. For example: if you use a grouping option of Node Name, all Availability exceptions

that fall within the time and topology constraints are grouped by Node Name and displayed as a per-
centage of the total samples in the left gauge.

The gauges across the top-5 lists provide the following exception count statistics:

l Memory Utilization Exceptions (% samples)

l Buffer Utilization Exceptions (% samples)

l Buffer Miss Rate Exceptions (% samples)

l CPU Utilization Exceptions (% samples)

If you want to investigate any of the gauge values further, click on the needle. The Report Menu will
appear with all of your current selections and the appropriate metric from the gauge. From here, you can
choose an appropriate report to provide further details.

The following top-5 lists tell you which nodes may be responsible for the exceptions showing up in the
gauges:

l Top 5 Qualified Component Names by Memory Utilization Exceptions

l Top 5 Qualified Component Names by CPU Utilization Exceptions

l Top 5 Qualified Component Names by Buffer Utilization Exceptions and Buffer Utilization Heat Chart

If you want to investigate any of the Top 5 values further, you can click on the selected element. The
Report Menu will appear with the appropriate metric from the Top 5 list and the selected element will be
added to your topology filters.

The top-5 list for discard exceptions includes a heat chart. Use the heat chart to highlight patterns over
time for the top 5 elements with discard exceptions.

Cells within the heat chart represent samples of time within the selected interval and the color of the cell
indicates the discard exception rate as a percentage of the total number of samples. These cells rep-
resent a period of time and are equivalent to the display grain used in other chart-style reports. For each
time range length, a default display grain is chosen. Display grains are selected dynamically by the
report and can have one of the following values:

l 1 Minute

l 5 Minutes

l 30 Minutes
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l 1 Hour

l 1 Day

When the NPS database has no data, the needle icons on the gauges on the Dashboard report do not
appear.

Use Case

If the gauges are showing few or no exceptions, this means that none of your nodes, including the nodes
in the top 5 lists, are experiencing problems with memory, buffer, or CPU utilization.

For example, your network is divided into groups that represent regions or strategic locations for your
enterprise. With the grouping option set to Node Group name, the report lists each of your strategic Node
Groups (as defined within NNMi) and provides the current statistics for exceptions within each group.

If an unexpected change in exception counts is noted, you can click the appropriate gauge needle or
Node Group within the Top 5 lists, and then launch another report (such as Chart Detail) to investigate
trends or changes within the network as they are occurring.

The thresholds that create exceptions are set from NNMi, not from the iSPI. If you want to set or modify

thresholds, refer to the online help for NNMi administrators.

Guided Tour - Component Health Dashboard Report

The following image shows a typical Dashboard report for the components on your network:

Exception Gauges

Memory and CPU Utilization Exceptions

Buffer Utilization Exceptions
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Top N Report

This report ranks network elements by the metric you select. Use this report to spot the element that per-
formed at the extremes. You can use this report to go back in time and investigate sampled data for ele-
ments that are exhibiting unusual utilization levels. The default metric is Memory Utilization.

The following are the available filters in the Time Controls pane for Top N Report:

l Start Date/Time - the default value depends on the default Time Range and data available in the
database

l Time Range - default is the last 1 hour

l Hour of day – default is All

l Day of W

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

Top N Summary defaults to:

l Components = All

l Rank Metric = Memory Utilization (Avg %)

l Top/Bottom N = Top 10

l Group By = Qualified Component Name

In addition to changing the metric, and modifying the time period, you can also change the ranking
number using the following options:

l Top 5

l Top 10

l Top 25

l Top 50

l Top 100

l Bottom 5

l Bottom 10

l Bottom 25

l Bottom 50

l Bottom 100
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l Sort All in Descending

l Sort All in Ascending

The following are the available options in the Report Options for the Top N report. You can select the
appropriate parameter from the drop-down:

l Top/Bottom 'N'

l Grouping by - default is “Qualified Component Name”

l Metric – default is “Memory Utilization (Avg %)”

l Display Time Series Chart

n Select Yes to view the detail chart with the table

n Select No to hide the chart and display only the table; default is No.

By default, the report groups data by Qualified Component Name. You can select multiple grouping attrib-

utes by using the (Add New Grouping) button. Use the (Remove Grouping) button to remove a
grouping attribute.

Click Show Chart to display the graphical representation of the metric values for the components over
the selected time range.

Use Case

Check this report once a day to see which elements may need special attention.

Check this report periodically throughout the day to see which elements are performing at the extremes
and may need special attention.

Managed Inventory Report

Use the Managed Inventory Report to view the number of instances of each topology attribute seen in
the collected data within the selected time range. For example, if the report is run for ‘Last 1 Hour,’ you
will see the number of unique values for each attribute seen in the data collected over the last hour. This
report can be useful for checking, for example, the number of nodes polled over any given time range.

You can use the available attributes to filter the data of your interest and create a report that represents
only the elements of your interest. The report presents the list of attributes in the form of a table; the
Count column of the table indicates the number of entries for each attribute. For example, count 5 for the
topology item Node Location means all nodes on your network can be grouped based on 5 different loca-
tions that host the nodes.

You can use the following topology attributes with the Component Health reports:

l Qualified Component Name

l Component Name

l Component Type

l Component ID

l Component UUID

l Node Name

l Node Contact

l Node Location

l Node Family

l Node Vendor
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l Node ID

l Node UUID

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

The Managed Inventory report may take significant time to build if you select a time range greater than
one day.

Interface Health Reports

The Interface Health reports show the performance data for network interfaces. Graphs and charts on
Interface Health reports reflect the details that help you identify the following:

l Interface utilization

l Errors in interfaces

l Interface discard rate

l Availability of interfaces

Use Interface Health reports to determine the status of the interfaces on your network.

Opening Reports from NNMi

From the NNMi Console, you have the following options to open reports:

l Move from NNMi to the iSPI, and launch reports from the Report Menu.

l Launch pre-filtered reports directly from NNMi.

If you are interested in a particular node group, node, or interface, you will probably want to launch a pre-
filtered report from NNMi; otherwise, open a workspace view from NNM, move to the iSPI, and begin your
investigation from Report Menu. To move from NNM to the iSPI: 

1. Log on to the NNMi console. 

2. Select a workspace. 

3. Open a view of nodes, interfaces, or incidents.

4. Select Actions > Reporting - Report Menu

Related Topics

Glossary of Metrics

Glossary of Metrics

l Availability

l Discard - Packets

l Discard Rate

l Errors

l Exceptions and Exception Rates

l Interface Speed

l Range

l Response Time

l Sample Count
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l Utilization

l Volume

Availability

Availability (Avg%): the average availability for all samples. Calculated by NNMi using multiple values
including but not limited to ifOperStatus, ifLastChange, ifAdminStatus.

Discards Packets

Total number of discarded packets, in and out combined, followed by number incoming packets and the
number of outbound packets.

l Discards Packets (sum)

l Discards Packets In (sum)

l Discards Packets Out (sum)

Discard Rate

Total number of packets with discards as a percentage of total packets (minimum, maximum, and aver-
age); followed by the number of discarded packets incoming, as a percentage of total incoming packets
(minimum, maximum, and average), and the number of discarded packets outbound, as a percentage of
total outbound packets (minimum, maximum, and average).

l Discard Rate (avg, min, and max)

l Discard Rate In (avg, min, and max)

l Discard Rate Out (avg, min, and max)

Errors

Total number of packets with errors, in and out combined; number of incoming packets with errors;
number of outbound packets with errors.

l Errors - Packets (sum)

l Errors - Packets In (sum)

l Errors - Packets Out (sum)

Total number of packets with errors as a percentage of total packets; followed by number of packets with
errors received as a percentage of total packets received, and number of packets with errors transmitted,
as a percentage of total packets transmitted.

l Error Rate (avg)

l Error Rate (min)

l Error Rate (max)

l Error Rate In (avg)

l Error Rate In (min)

l Error Rate In (max)

l Error Rate Out (avg)

l Error Rate Out (min)

l Error Rate Out (max)

Exceptions

Utilization Exceptions: number of exceptions; percentage of samples above the normal range or below
the normal range.
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l Utilization Exceptions (#samples)

l Utilization Exceptions (%samples)

Discard Exceptions: number of packet discard exceptions; percentage of samples above the discard
exception threshold.

l Discard Exceptions (#samples)

l Discard Exceptions (%samples)

Error Exceptions: number of packet error exceptions; percentage of samples above the error exception
threshold.

l Error Exceptions (#samples)

l Error Exceptions (%samples)

Availability Exceptions: number of availability exceptions; percentage of samples showing ifOperStatus =
down.

l Availability Exceptions (#samples)

l Availability Exceptions (%samples)

Interface Speed (bps)

Period Length (sec): time represented by poller intervals.

Range (Discard Rate, Error Rate, Utilization)

The average +/- 1 Standard Deviation.

Standard deviation is the square root of variance. Standard deviation measures the spread of data
around the mean. When many data points are close to the mean, then the standard deviation is small;
when many data points are far from the mean, then the standard deviation is large.

Response Time

Network Delay (Avg msec): time for interface/device to respond to polling request

Sample Count

Sample count = number of polled samples.

Utilization

Utilization - Avg%: average utilization in; average utilization out

l Utilization In (Avg%)

l Utilization Out (Avg%)

Utilization - Max%: maximum utilization in (the largest value from any sample); maximum utilization out
(the largest value from any sample)

l Utilization In (Max%)

l Utilization Out (Max%)

Utilization - Variance: the average of the squared differences between data points and the mean. Var-
iance is tabulated in units squared.

l Utilization In (Variance)

l Utilization Out (Variance)
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Volume

l Volume - Packets (sum): total packet count in; total packet count out.

l Volume - Packets In (sum): total packet count in

l Volume - Packets Out (sum): : total packet count out

l Volume -Bytes (sum): total byte count in; total byte count out

l Volume - Bytes In (sum): total byte count in

l Volume - Bytes Out (sum): total byte count out

Reports

The Interface Health extension pack presents the following reports:

l Calendar

l Chart Detail

l Heat Chart

l Most Changed

l Top N

l Managed Inventory

l Dashboard

l Headline

Related Topics

Glossary of Metrics

Calendar Report

The Calendar Report uses a traditional, calendar-style layout to show hourly statistics for two metrics in a
single, extended graph spanning over multiple days.

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

The Calendar Report defaults to:

l Interfaces = All

l Dates/Times = Last 31 days

l Primary Metric (yellow in the graph) = Discards-Packets (sum)

l Secondary Metric (blue in the graph) = Availability- Exception Rate (max)

The default view shows data for the current month. Depending on how long the iSPI has been collecting
data from NNMi, you may have the option of looking at data for the previous 70 days if you use the option
Until Now.

Note: If you set the Time Range below 24 hours, the following message appears:
This report is not designed to operate with a time range of less than 24 hours.
Please modify your time selections.

Use Case
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Use this report to observe:

l gradual trends over time

l isolated spikes

l to verify that an abnormal condition has returned to normal

l to make comparisons

This report also reveals:

l Day of week patterns

l Hour of day patterns

For example, if utilization is spiking on Tuesdays, or if response time issues are occurring daily at 11:00
a.m., the report will highlight these events.

Related Topics

Guided Tour - Interface Health Calendar Report

Guided Tour - Interface Health Calendar Report

The following image shows a typical calendar report for the interfaces on your network:

Related Topics

 Calendar Report

Chart Detail Report

Use the Chart Detail Report to examine sampled data for any two metrics in detail. This report contains a
graph representing data samples of two metrics.

The following are the available filters in the Time Controls pane for Chart Detail Report:
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l Start Date/Time

l Time Range

l Display Grain

l Hour of day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

The graph on this report tracks two metrics over the selected time period. Unless you modify the defaults,
Chart Detail defaults to the following:

l Interfaces = All

l Primary metric = Discards - Packets (sum)

l Secondary metric = Availability - Exception Rate (max)

The Chart Detail report enables you to view the data in the tabular format as well. To view the table, click
Options, and then select Table. The Table appears instead of the chart. To view both the chart and the
table, click Options, and then select Chart and Table.

Related Topics

Guided Tour - Interface Health Chart Detail Report

Guided Tour - Interface Health Chart Detail Report

The following image shows a typical Chart Detail report for the interfaces on your network:

Related Topics

Chart Detail Report
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Dashboard Report

The Dashboard Report provides an overview of the interfaces available on your network using a com-
bination of gauges, heat charts, and ordered Top 5 lists. The focus of the report is interface-based thresh-
old breaches, which are classed as exceptions. Threshold breaches can point to a network-related
problem or may indicate that your thresholds within NNMi need to be changed.

While exceptions usually point to actual problems, it is possible that a high number of thresholds merely
indicates that your thresholds are not set properly, in which case your thresholds need to be changed.

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

Like all other reports, the Dashboard Report includes a Time Control and a Topology Filter that enable

you to modify the time range displayed and the network elements whose data will be used to form the
report.

The Dashboard report also includes a Group By option. The Group-By option only applies to three top 5
lists. You can group the data within the report using the grouping option.

The gauges across the top provide the following exception count statistics:

l Availability Exceptions (% samples)

l Utilization Exceptions (% samples)

l Discard Rate Exceptions (% samples)

l Error Rate Exceptions (% samples)

If you want to investigate any of the gauge values further, click on the needle. The Report Menu will
appear with all of your current selections and the appropriate metric from the gauge. From here, you can
choose an appropriate report to provide further details.

The following top-5 lists tell you which elements may be responsible for the exceptions showing up in the
gauges:

l Top 5 elements by Utilization Exceptions

l Top 5 elements by Availability Exceptions

l Top 5 elements by Discard Exceptions

If you want to investigate any of the Top 5 values further, you can click on the selected element. The
Report Menu will appear with the appropriate metric from the Top 5 list and the selected element will be
added to your topology filters.

The top-5 list for discard exceptions includes a heat chart. Use the heat chart to highlight patterns over
time for the top 5 elements with discard exceptions.

Cells within the heat chart represent samples of time within the selected interval and the color of the cell
indicates the discard exception rate as a percentage of the total number of samples. These cells rep-
resent a period of time and are equivalent to the display grain used in other chart-style reports. For each
time range length, a default display grain is chosen. Display grains are selected dynamically by the
report and can have one of the following values:

l 1 Minute

l 5 Minutes
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l 15 Minutes

l 30 Minutes

l 1 Hour

l 1 Day

The defaults filter setting are:

l Nodes/Components = All

l Time Period = Last 1 Hour

l Hour of Day = All

l Day of Week = All

When the NPS database has no data, the needle icons on the gauges on the Dashboard report do not
appear.

Use Case

If the gauges are showing few or no exceptions, this means that none of your nodes, including the nodes
in the top 5 lists, are experiencing problems with Availability, Utilization, Discard Rate, and Error Rate.

If, for example, your network is divided into groups that represent regions or strategic locations for your
enterprise. Auto refresh would be enabled and set to 5 minutes, a time interval of 'Last 1 Hour' could be
used. With the grouping option set to Node Group Name, the report will list each of your strategic Node
Groups (as defined within NNMi) and provide the current statistics for exceptions within each group.

If an unexpected change in exception counts is noted, you can click the appropriate gauge needle, or
Node Group within the Top 5 lists, and then launch another report (such as Chart Detail) to investigate
trends or changes within the network as they are occurring.

The thresholds that creates exceptions are set from NNMi, not from the iSPI. If you want to set or modify
thresholds, refer to online help for NNMi administrators.

Related Topics

Guided Tour - Interface Health Dashboard Report

Guided Tour - Interface Health Dashboard Report

The following image shows a typical Dashboard report for the interfaces on your network:

Exception Gauges
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Utilization and Availability Exceptions

Discard Exceptions

Related Topics

 Interface Health Dashboard Report

Headline Report

The Headline Report provides a broad view of performance. Presents 8 different graphs on a single
page. This report enables you to view every aspect of performance at once. The default view is the yes-
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terday's performance. Use the graphs to view trends, spot isolated spikes, exceptions, and verify that per-
formance is meeting expectations.

The following are the available filters in the Time Controls pane for Headline Report:

l Start Date/Time

l Time Range

l Display Grain

l Hour of day

l Day of Week

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

Features and Defaults

The Headline Report contains the following graphs:

l Volume (in and out)

l Availability

l Utilization (Avg %)—in and out; Utilization Exceptions—in and out

l Discard Rate (Max %)—in and out; Discard Rate Exceptions—in and out

l Error Rate (Max %)—in and out; Error Rate Exceptions—in and out

Note: The Headline report does not provide options to create graphs on other metrics.

The Headline Report defaults to:

l Components = All

l Time Period = Last 1 Hour

l Hours of Day = All

l Days of Week = All

Use Case

The range data (for utilization, discard rate, and error rate) helps you measure the variance and enables
you to decide on setting the thresholds if needed. This report shows data for exceptions only if thresholds
for performance metrics are set in NNMi.

For the set thresholds, if the performance exceptions occur, exceptions appear as red stars on the range
graphs.

If you are viewing data for a particular day, the metrics are aggregated to the hourly level. All other time
periods show data aggregated to the daily level.

Related Topics

Guided Tour - Interface Health Headline Report

Guided Tour - Interface Health Headline Report

The following image shows a typical Headline report for the interfaces on your network:

Volume and Availability
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Utilization and Exceptions

Discard Rate and Exceptions
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Error Rate and Exception

Related Topics
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Headline Reports

Most Changed Report

This report compares performance the components for two different (consecutive) time periods and ranks
components by the amount of change. The sort order is most-changed to least-changed.

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

This report contains one table. The table provides data for one metric only.

The table columns are:

Interface

l Grouping by Elements

l Performance for the previous time period

l Performance for the current time period

l Growth, expressed as a percentage increase

l Change

The Most Changed report defaults to:

l Grouping by Elements = Qualified Interface Name

l Start Date/Time = depends on default Time Range and data available in database

l Dates/Times = Last Day

l Time Range = Last 1 Hour

l Protocols = All

l Speeds = All

l Hour of Day HOD = All

l Day of Week DOW = All

l Ranking Metric = Discards – Packets (sum) Utilization (Avg %)

l Top N Option = Top 10

l Nodes or Interfaces = Node

The report-specific options are:

l Rank Metric

l Top N

l Nodes or Interfaces

Your Top N options are:

l Top 25

l Top 10

l Top 5
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By default, the report groups data by Qualified Component Name. You can select multiple grouping attrib-

utes by using the (Add New Grouping) button. Use the (Remove Grouping) button to remove a
grouping attribute.

Use Case

Use this report to spot nodes or interfaces that saw significant growth from the previous selected time
period to the selected time period. Significant growth could point to a developing problem you need to
know about. You can change the ranking metric and you can change how many elements are listed.

Note: Since the Most Changed report compares performance in two continuous time periods, the “Until
Now” option for All Dates/Times is not a valid time period. Selecting “Until Now” for Time Range will dis-
play the following error:

This report does not operate with the current time interval. Please modify your selection.

Related Topics

Top N Report

Guided Tour - Interface Health Most Changed Report

The following image shows a typical Most Changed report for the interfaces on your network:

Related Topics

 Most Changed Report

Top N Report

This report ranks the elements, by the metric you select. Use this report to spot the element that per-
formed at the extremes. You can use this report to go back in time and investigate sampled data for ele-
ments which are exhibiting unusual utilization levels.

The following are the available filters in the Time Controls pane for Top N Report:

l Start Date/Time - the default value depends on the default Time Range and data available in the
database

l Time Range - default is the last 1 hour

l Hour of day – default is All

l Day of Week – default is All
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To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

To change the Report Options defaults, see "Change Report Options".

Features and Defaults

Top N Summary defaults to:

l Interfaces = All

l Rank Metric = Discard - Packets (sum)

l Top/Bottom N = Top 10

l Group By = Qualified Interface Name

In addition to changing the metric, and modifying the time period, you can also change the ranking
number using the following options:

l Top 5

l Top 10

l Top 25

l Top 50

l Top 100

l Bottom 5

l Bottom 10

l Bottom 25

l Bottom 50

l Bottom 100

l Sort All in Descending

l Sort All in Ascending

The following are the available options in the Report Options for the Top N report. You can select the
appropriate parameter from the drop-down:

l Top/Bottom 'N'

l Grouping by - default is “Qualified Interface Name”

l Metric – default is “Discards – Packets (sum)”

l Display Time Series Chart

n Select Yes to view the detail chart with the table

n Select No to hide the chart and display only the table; default is No.

By default, the report groups data by Qualified Component Name. You can select multiple grouping attrib-

utes by using the (Add New Grouping) button. Use the (Remove Grouping) button to remove a
grouping attribute.

Click Show Chart to display the graphical representation of the metric values for the components over
the selected time range.

Use Case

Check this report once a day to see which elements may need special attention.
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Check this report periodically throughout the day to see which elements are performing at the extremes
and may need special attention.

Related Topics

Most Changed Report

Managed Inventory Report

Use the Managed Inventory Report to view the number of instances of each topology attribute seen in
the collected data within the selected time range. For example, if the report is run for ‘Last 1 Hour,’ you
will see the number of unique values for each attribute seen in the data collected over the last hour. This
report can be useful for checking, for example, the number of nodes polled over any given time range.

You can use the available attributes to filter the data of your interest and create a report that represents
only the elements of your interest. The report presents the list of attributes in the form of a table; the
Count column of the table indicates the number of entries for each attribute. For example, count 5 for the
topology item Node Location means all nodes on your network can be grouped based on 5 different loca-
tions that host the nodes.

You can use the following topology attributes with the Interface Health reports:

l Qualified Interface Name

l Interface Name

l Interface Alias

l Interface Descr

l Interface Index

l Interface Type

l Interface Physical Address

l Interface Speed (In:Out)

l Interface ID

l Interface UUID

l Node Name

l Node Contact

l Node Location

l Node Family

l Node Vendor

l Node ID

l Node UUID

To change the Time Controls defaults, see "Change Time Controls".

To change the Topology Filters defaults, see "Set Topology Filters".

The Managed Inventory report may take significant time to build if you select a time range greater than
one day.

Path Health Overview

Path Health displays icons representing the nodes and interfaces in a path. A vertical chain of nodes and
interfaces represents the path from one managed element to another. Each step along the path (node or
interface) shows a series of small pie charts and trend lines depicting activity and performance for that
element over the previous six hours.
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Path Health helps you analyze the following:

l Ratio of exceptions per metric over the last hour (one pie chart per metric)

l Metric values over the last six hours (one graph per metric)

Use them to view whether the values are:

l static

l rising steadily

l falling steadily

l fluctuating

1. From one of the NNMi inventory views, select two elements.

2. Select Action-->Path View from the NNMi console to view the Path View page.

Note: The only way to launch Path Health is from a Path View in NNMi.

2. From the Path View, select Actions-->Reporting - Path Health

The Path View page opens with the following segment menus:

l Source Node: The first element of the selected path

l Destination Node: The last element of the selected path

3. Select Actions-->Reporting - Path Health to create the Path Health report.

If the Path View is showing multiple paths between hops, NNMi will ask you to select a specific path. To
make the choice, click the appropriate connecting line within NNMi. The colors on the screen will change
when you make the selection. The Path Health option under Actions does not function until your selec-
tions are complete.

Launch Path Health Reports for Nodes with Multiple paths

NNMi console may often present more than one path between your source and destination nodes. When
you request the Path Health report using the Actions > Reporting - Path Health menu, the left-most icon
on the path changes color if multiple paths exist between the source and destination nodes. To launch a
Path Health report, select a particular path by clicking every visible node on the path, and then click
Actions > Reporting - Path Health.

Features and Defaults

The Path Health report pulls data from the following extension packs:

l Component Health

l Interface Health

From the Component Health collections, Path Health generates the following statistics for a node in a
path:

l CPU exceptions last hour / CPU utilization last six hours

l Memory exceptions last hour / Memory utilization last six hours

l Buffer exceptions last hour / Buffer utilization last six hours

From the Interface Health collections, Path Health generates the following statistics for an interface in a
path:

l Utilization exceptions last hour / Utilization over the last six hours

l Discard exceptions last hour / Number of discards per poll over the last six hours

l Error exceptions last hour / Number of errors per poll last six hours
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The Path Health report pulls data from two Tables:

l Component Health Live Table

l Interface Health Live Table

Use Case

Use Path Health to monitor the fault conditions that are showing up in a Path View. The performance
data in Path Health can help you determine what is causing the fault condition you are seeing in the Path
View.

If a node, or interface, or component, in the Path Health report is showing exceptions, you can easily find
more information about those by clicking the links for node, interface, or component.

For example, if a node is showing CPU exceptions, you could open Report Menu, select a appropriate
report, and then drill down on the node until you identify the specific component that is reporting prob-
lems.

Path Health Report

Path Health displays icons representing the nodes and interfaces in a path. A vertical chain of nodes and
interfaces represents the path from one managed element to another. Each step along the path (node or
interface) shows a series of small pie charts and trend lines depicting activity and performance for that
element over the previous six hours.

Path Health helps you analyze the following:

l Ratio of exceptions per metric over the last hour (one pie chart per metric)

l Metric values over the last six hours (one graph per metric)

The selected Path View displays as shown below.

The pie chart enables you to view the comparison between the number of polls which are below or
above the set threshold. The data shown in the pie chart represents the samples collected within the last
hour.

The line graphs track sampled data over the previous six hours.

Unknown Items

Unknown icons (icons associated with the ? icon) appear in the Path Health report for a device or inter-
face that is not being polled for the required data. The Path Health report presents Component Health
data for each node and Interface Health data for each interface. It is possible that a node can support the
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Interface Health collections (MIB-II), but not the Component Health collections. For this reason, the report
may display data regarding the inbound and outbound interfaces on a node but not about the node itself.

Setting Polling Characteristics in NNMi

Only if you use the iSPI Performance for Metrics.

Performance polling has an impact on NNMi and it also has an impact on your network. If you enable
additional performance polling, NNMi will have to allocate a portion of its resources to handle the addi-
tional polling, and your network will have to accommodate an increase in SNMP traffic. So that system
and network resources are used wisely, not wasted, it is important to limit performance polling to the
devices you care about most.

By default, NNMi enables performance polling for the.following Node Group:

l Routers

These are some of the ways you can modify the performance polling defaults that will be in place right
after the iSPI is installed:

1. Set thresholds for a node group that you are already polling for performance data (no thresholds are
set by default).

2. Modify the frequency of performance polling.

3. Add nodes to the Important Nodes group, and enable performance polling for this group.

4. Enable performance polling for the select group.

Items 1 through 4 are monitoring configuration tasks. Monitoring configuration tasks are related to poll-
ing.

Defining How a Node Group Will be Polled

If you want to enable polling, or modify polling, open the Monitoring Configuration window. Select:

Workspaces > Configuration > Monitoring Configuration

The Monitoring Configuration window has three tabs:

l Interface Settings

l Node Settings

l Default Setting

To configure polling for a node group, click the Node Settings tab, select the group you want to con-
figure, and then click the Open icon. The Node Setting form opens. On the left side of this form, there are
several options related to polling:

l ICMP and SNMP fault monitoring

l Performance monitoring

l Polling interval, defined by days, hours, minutes, and seconds

On the right side of this form you have a Threshold Settings form, where you can set High Value and Low
Value thresholds for certain metrics that NNM is polling.

Creating a New Node Group and Setting the Filter Status

The following tasks are monitoring tasks:
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l Creating a new node group in NNMi

l Making a node group function as a filter in various NNMi views

l Making a node group function as a filter in iSPI topology filters

To perform these tasks, you need to open the Node Groups window. Open that window by selecting:

Workspaces > Configuration > Node Groups

If you want to modify the filter status, open the node group you want to modify and look for the filter
options on the left side of the window. If you want to create a node group, click the New icon and then
define the contents of the group by setting device-level filters.

If you want operators to see a particular node group in iSPI topology filters, you must enable the Add to
iSPI Filter List option on the left side of the Node Groups window.

See NNMi online help for Administrators if you need help creating new node groups or setting the filter
status options.

Modifying Topology Attribute Values and Group Memberships from NNMi

The topology attributes and groups help you filter the data and build the report with the data polled from
nodes and interfaces of your interest. The NPS retrieves the topology attribute details from NNMi and
other iSPIs. If you make modifications to topology attributes and group memberships from NNMi, the
changes are reflected in the NPS within about an hour.

Changes are not applied retroactively to the existing data. Changes are always forward -looking; the
NPS preserves the historical accuracy of the data ‘as it was’ when it was collected.

For example:

l If a new node is added to a group, it is only added for the new data collected going forward. The
NPS cannot assume that the node was a member of the group in the past.

l If an interface attribute changes—for example, ifSpeed is changed from old to new value, it is only
applied going forward. The NPS does not assume that the new speed applies to the historical data.

If you delete or change a member of a topology attribute, the old member continues to appear in the list
of topology filters in NPS. The old attribute member continues to appear in the list of topology filters. If
you select the old member, the data that was collected before making the change gets sampled in the
report.

Example

If you modify the node group name A to B in the NNMi console, the new node name gets reflected in
NPS after at least an hour. Later on, the old node group name continues to appear in the list of Node
Groups in the Topology Filters section. However, when you select A, you cannot retrieved data samples
associated with A that are polled after changing the Node Group name to B.

For example, you might have an interface group called “Oracle Server Ports” identifying switch interfaces
assigned to your Oracle Server cluster, but now you have a new server cluster available online, and you
want to transfer your Oracle applications to the new one, and re-purpose the old servers to host the Micro-
soft Exchange Server.

Therefore, you rename “Oracle Server Ports” to “Exchange Server ports” and create a new interface
group for “Oracle Server Ports” identifying the ports associated with the new servers. If you want to run a
report at the end of the month to see the health of your “Oracle Server Ports” and your new “Exchange
Server Ports” over the month, the NPS will define “Oracle Server ports" group to include the data col-
lected for the original ports up until the point you made the change, and for the new ports after that point.

Similarly, the NPS will define the “Exchange Server ports” group to only include the ports from the point
the group was renamed—it does not include the ports while they were still being used for Oracle.
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Overview of Custom Poller Configuration

Available only with the iSPI Performance for Metrics.

After the 30-day evaluation period, you can view reports based on Custom Poller collections only if you
obtain a license for the iSPI Performance for Metrics.

NNMi's Custom Polling feature enables the NNMi administrator to take a proactive approach to network
management by gathering additional device information using SNMP MIB variables.

For example, an NNMi administrator might want NNMi to monitor the Status of COM (communication)
ports on all of your Windows servers.

Using Custom Poller, the NNMi administrator can also configure NNMi to do the following:

l Send incidents when certain MIB values are detected

l Map returned MIB values to States and include these States as part of node Status calculations.

The NNMi Custom Poller feature enables network operators to:

l View the list of topology nodes for which additional information is being polled as well as the name

of the associated Policy.

l View the polling results. The first time the results for a specified MIB variable are discovered, the
results appear in a Polled Instance object. The Polled Instance object is updated whenever a
change in State is detected and includes the most current polled value that caused the State to
change.

l View incidents that are generated by Custom Poller for a MIB Poll Variable.

You can use the data collected by Custom Poller collections to construct and view reports if you use the
iSPI Performance for Metrics.

Overview of Custom Poller Collections and Their Associated Policies

Note: See NNMi online help for more information on Custom Poller.
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Reports for Custom Poller Collections

If you use the Custom Poller feature of NNMi, you can configure the iSPI Performance for Metrics to
create reports based on the data collected by NNMi's Custom Poller. The Report Groups tab in the Cus-
tom Poller Configuration form enables you to generate reports from the metrics obtained from Custom
Poller collections.

The iSPI Performance for Metrics creates new extension packs to display reports generated from the
data collected by Custom Poller collections.

Mechanism of Creating Additional Extension Packs

When you add a report group to the Report Groups tab, NNMi creates an extension pack for each SNMP
MIB table referenced in the Custom Poller collection. On the iSPI Performance Report Menu page, the
extension pack reflects the name of the SNMP MIB table. Multiple Custom Poller collections are com-
bined into a single extension pack if the collections use OIDs from the same MIB table.

Create Extension Packs for Custom Poller Collections

To create an extension pack for a Custom Poller Collection, you must create a report group for a Custom
Poller Collection from the NNMi console.

Prerequisite: You must log on to the NNMi console with the administrative privilege.

Task 1: Create a Custom Poller Collection

Create a Custom Poller Collection in the Custom Poller Configuration form by following the instructions
in NNMi Help for Administrators.

Task 2: Create a Custom Poller policy

Create a Custom Poller policy in the Custom Poller Configuration form by following the instructions in
NNMi Help for Administrators.

Task 3: Create an extension pack for a Custom Poller Collection

1. Navigate to the Custom Poller Configuration form.

a. From the workspaces navigation pane, select the Configuration workspace.

b. Select Custom Poller Configuration.

2. In the Custom Poller Configuration form, go to the Report Groups tab.

3. Click New ( ). The Report Group form opens.

4. In the Report Group form, specify a name for the extension pack in the Basics section. Do not use
spaces in the name.

5. In the Report Collections tab, click New ( ). The Report Collections form opens.

6. To add a Custom Poller Collection to the report group, click (the Lookup icon):

n To specify a Custom Poller Collection, click (Quick Find).

n To create a new Custom Poller Collection, click (New).

7. Set the Report Data Type to one of the following values:

n Gauge: Represents single non-cumulative values. Examples of Gauge data types include
Response Time, Bit Rate, and Temperature. During aggregation, the iSPI Performance for Met-
rics calculates the minimum, maximum, and average values of gauge metrics.
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n Percent: Represents single non-cumulative values that are formatted with a percent sign (%)
and two decimal places. Examples of Percent data types include Utilization and Discard Rate.
During aggregation, the iSPI Performance for Metrics calculates the minimum, maximum, and
average values of percent metrics.

n Counter: Represents incremental values. Examples of Counter data types include byte counts,
packet counts, and flow counts.

8. In the Report Collections form, click Save and Close.

9. In the Report Group form, click Save and Close. The iSPI Performance for Metrics creates a new
extension pack and adds a new tab on the Report Menu page.

Guidelines to Create Custom Poller Extension Pack

l You can associate a Custom Poller Collection to only one report group.

l If you associate more than one Custom Poller Collection with the same Report Group, make sure
the combination of Collections generates a meaningful report. As a general guideline, select Col-
lections whose MIB Variables represent the same index value across Custom Poller Collections.

l Avoid using keyboard symbols while naming the Custom Poller collection and customPoll OID. If

you still use the following symbols <,>,”,’,&,\, they are replaced by a ! character in the report.

l Reports are not created if the # symbol is used in a customPoll name.

Remove Custom Poller Extension Packs

If you want, you can remove the extension packs. The iSPI Performance for Metrics provides you with
command line tools to remove Custom Poller extension packs.

To remove Custom Poller extension packs:

1. Log on with the administrative or root privileges to the system where the iSPI Performance for Met-
rics is installed.

2. Go to the following directory:

n On Windows: <Install_Dir>\NNMPerformanceSPI\bin

n On UNIX or Linux: /opt/OV/NNMPerformanceSPI/bin

3. Run the following command to view the list of extension packs:
uninstallExtensionPack.ovpl

4. Run the following command:
uninstallExtensionPack.ovpl -p <extension_pack_name>

Note: You cannot recover the data associated with an extension pack if you inadvertently delete it. Make
sure to type the correct extension pack name with the command. Do not delete the following
default iSPI Performance for Metrics extension packs unless you want to remove iSPI Per-
formance for Metrics reports: Interface_Health, Component_Health. If you delete the Perf-
SPI_Diagnostics.extension pack, you will not be able to monitor the health of the NPS
processes.

Custom Poller Report Controls

You can use the standard report control links to access Time Controls, Topology Filter, Report Options
and Adjust Time Range filters. You can search using any of the available attributes and set filters to
create a report based on the modification.

Note: The functional aspects of the filters in Report Controls for Custom Poller extension packs are the
same as default extension packs, but with few options.
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Time Controls

The Time Controls pane helps you change the default filters to create a report based on the modification.

Filter Usage

Click the drop-down calendar box and select the appropriate date.

By default, the date is automatically set to the current date when you select the Time
Range.

To set the time manually, select the Hour/Minutes/Meridian options separately, and then
select the value by clicking the arrow.

By default, the time is automatically set to the current time when you select the Time
Range. 

Time
Range

Click the drop-down menu to display the list of time ranges, and then select the appropriate
time.

If you select a time range that is beyond the Start Date and Time, the following message
appears:

Your start date/time is out of range. It will be adjusted. 

Click OK to adjust accordingly.

Auto
Refresh

Click the drop-down menu, and then select the desired time to recreate the reports based
on the set interval.

By default, the Auto refresh is OFF.

The Auto Refresh option appears on the Time Controls page only after the first report is gen-
erated.

Filters

Topology Filter

The Topology Filter enables you to quickly find or select an element from the topology table using selec-
tion mechanisms appropriate for the attribute type.

Attribute Parameter

Node
Group
Name

Contains the list of the available Node groups in the network.

Node
Name

Contains the list of the available Node name in the network.

Node
Contact

Contains the list of the available Node Contact in the network.

Node
Location

Contains the list of the available Node Location in the network

Node
Family

Contains the list of the available Node Families in the network.

Attributes and Related Parameters in the Topology Filter

Page 92 of 97



iSPI Performance for Metrics Online Help
Welcome to the iSPI Performance for Metrics

Attribute Parameter

Node
Vendor

Contains the list of the available Vendors in the network.

Node ID Contains the list of the available Nodes ID in the network.

Node
UUID

Contains the list of the available Node UUID in the network.

Index Contains the list of the available Index in the network. This field contains the SNMP index
OID values that identify specific MIB table instances polled by Custom Poller policies; if you
want, you can use these SNMP index OID values to filter Custom Poller reports to show
only specific instances from the MIB table (use in conjunction with the NodeName filter).

Report Options

Report options provide a list of primary and secondary metrics for the selected Custom Poller extension

pack.

Note: The metrics drop-down list differs according to the selected extension pack.
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utilization exceptions (defined) 71
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